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General Safety Summary

To Avoid Fire or
Personal Injury

Symbols and Terms

/N

Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it. To avoid potential hazards, use this
product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of the system. Read
the General Safety Summary in other system manuals for warnings and cautions
related to operating the system.

Connect and Disconnect Properly. Do not connect or disconnect probes or test
leads while they are connected to a voltage source.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

Do Not Operate With Suspected Failures. If you suspect there is damage to this
product, have it inspected by qualified service personnel.

Terms in this Manual. These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

VAN

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.

Terms on the Product. These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the
marking.

WARNING indicates an injury hazard not immediately accessible as you read the
marking.

CAUTION indicates a hazard to property including the product.

Symbols on the Product. The following symbol may appear on the product:

A\

CAUTION Refer to Manual

TDSIJIT2 Jitter Analysis Application User Manual ix
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Preface

This manual contains operating information for the TDSJIT2 Jitter Analysis
Application. The manual consists of the following chapters:

B The Getting Started chapter briefly describes the TDSJIT?2 Jitter Analysis
Application, lists oscilloscope compatibility, and provides installation
instructions.

®  The Operating Basics chapter covers basic operating principles of the
application and includes a tutorial that teaches you how to set up the
application to acquire a waveform, take measurements, and view the results.

To show you how to operate the application using GPIB commands, this
chapter includes a simple GPIB program.

B The Reference chapter includes a diagram of the menu structure and
descriptions of parameters.

B The Measurement Algorithms appendix contains information on measure-
ment guidelines and on how the application takes the measurements.

®  The GPIB Command Syntax appendix contains a list of arguments and values
that you can use with the GPIB commands and their associated parameters.

Related Documentation and Online Help

You can access information on how to operate the oscilloscope and application
through the following related documents and online help:

Oscilloscope Information. The user manual for your oscilloscope provides
general information on how to operate the oscilloscope.

Application Online Help. The application has an online help system that covers all
its features. You can access the help topics through a table of contents or index.

Programmer Information. The online help for your oscilloscope provides details
on how to use GPIB commands to control the oscilloscope.

You can also download this file with examples from the www.Tektronix.com web
site. Refer to Updates Through the Web Site on page 1-2 for information on how
to download the file.

TDSJIT2 Jitter Analysis Application User Manual Xi
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Installation Manual. The Optional Applications Software on Windows-Based
Oscilloscopes Installation Manual contains the following information:

Software warranty (same as in this manual)
Software license agreement

List of all available applications, compatible oscilloscopes, and relevant
software and firmware version numbers

How to apply a new label
Installation instructions based on the type of oscilloscope,
How to enable an application

How to download updates from the Tektronix web site

NOTE. The installation manual always contains the most up-to-date information
and procedures. Since installation procedures may be different for the TDS7000
series and subsequent oscilloscopes, be sure to check the installation manual
before you install the application software.

You can find a portable document format (PDF) file of the installation manual in
the Documents directory on the Optional Applications Software on Windows-
Based Oscilloscopes Installation CD-ROM.

This manual uses the following conventions:

Conventions
| |
| |
| |
Xii

This manual refers to the TDSJIT2 Jitter Analysis Application as the
TDSIJIT?2 application or as the application.

This manual refers to any product on which this application will run as an
oscilloscope

When steps require that you make a sequence of selections using the
application interface, the > delimiter marks each transition menus and
options. For example, one of the steps to recall a setup file would appear as
Measurements> Save/Recall> Recall.

TDSJIT2 Jitter Analysis Application User Manual
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Contacting Tektronix

Phone

Address

Web site
Sales support
Service support

Technical support

1-800-833-9200*

Tektronix, Inc.

Department or name (if known)
14200 SW Karl Braun Drive
P.O. Box 500

Beaverton, OR 97077

USA

www.tektronix.com
1-800-833-9200, select option 1*
1-800-833-9200, select option 2*
Email: techsupport@tektronix.com

1-800-833-9200, select option 3*
1-503-627-2400

6:00 a.m. - 5:00 p.m. Pacific time

*  This phone number is toll free in North America. After office hours, please leave a
voice mail message.
Outside North America, contact a Tektronix sales office or distributor; see the
Tektronix web site for a list of offices.

TDSJIT2 Jitter Analysis Application User Manual
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Product Description

Compatibility

The TDSJIT2 Jitter Analysis Application is a Java-based application that
enhances basic capabilities of some Tektronix oscilloscopes.

The application provides jitter analysis measurements, can display the statistical
results of up to six measurements, can display the results as plots, can save the
results to a data log file, and can save the worst case waveforms to files.

Figure 1-1 shows an example of statistical results for a Clock Period measure-
ment in the application part of the display (lower half) and a Histogram plot of
those results in the oscilloscope part of the display (upper half).

[ “Tektronjx “ J [ — }

e i Veica Hpacq Iog Diphy Duios  Messue  Mah Ui

...@

(I

Figure 1-1: TDSJIT2 Jitter Analysis Application

The Jitter Analysis Application is compatible with several TDS7000 series
oscilloscopes. Table 1-1 lists the oscilloscopes and firmware version numbers.

Table 1-1: Compatible oscilloscopes

Model number* Firmware version
TDS7054 and TDS7104 1.2.0 and above
TDS7404 1.3.0 and above
TDS7254 1.3.1 and above
TDS5054 and TDS5104 1.0.0 and above

*  For a current list, see the Software and Drivers category on www.tektronix.com.

TDSJIT2 Jitter Analysis Application User Manual 1-1



Product Description

Requirements and Restrictions

The Sun® Java Run-Time Environment V1.2.2 or above must be installed on the
oscilloscope to operate the TDSJIT2 application.

NOTE. This application may be compatible with future models of oscilloscopes
that have different specifications. If this occurs, menus or options that are
unavailable will appear dim if they are beyond the acquisition capability of the
oscilloscope.

Updates Through the Web Site

Accessories

1-2

You can find information about this and other applications at the Tektronix Inc.
web site, www.tektronix.com. Check this site for application updates and for
other free applications.

To install an application update, you will need to download it from the Tektronix
web site to the oscilloscope hard disk.

NOTE. More information about changes to the application or installation is in a
Readme.txt file on the web site. You should read it before you continue.

To download an application from the web site, follow these steps:
1. Access www.tektronix.com/Software & Drivers/Oscilloscopes.

2. Scroll through the files to the application that you want, select the file, and
download it to your hard disk drive. If necessary, unzip the file.

If your oscilloscope is connected to a network, you do not need to follow the
remaining steps.

3. If your oscilloscope is not connected to a network, copy the application from
the hard disk to blank, DOS-formatted floppy disks.

NOTE. To ensure that the files were downloaded successfully, always unzip the
files on a hard disk before copying them to floppy disks.

4. To install the application, follow the From Floppy Disks procedure on
page 1-5.

There are no standard accessories for this product other than this manual.

TDSJIT2 Jitter Analysis Application User Manual



Installation

Applying a New Label

This section contains information on the following tasks:
®  Applying a new label

®  [Installing the TDSJIT2 application

®  Enabling the application

B Deskewing the probes and channels

B Connecting to a system under test

NOTE. The Optional Applications Software on Windows-Based Oscilloscopes
Installation Manual contains up-to-date information and procedures. Since
installation procedures may be different for the TDS7000 series and other
oscilloscopes, be sure to check this manual before you install the software.

You can find a portable document format (PDF) file of the installation manual in
the Documents directory on the Optional Applications Software on Windows-
Based Oscilloscopes Installation CD-ROM.

If you receive a newer version of this application, or purchase an application that
did not exist when you bought your oscilloscope, you need to apply a new label
to the rear panel of the oscilloscope. The label contains important information,
such as the serial number of the oscilloscope, options purchased for that serial
number, and an authorized Option Installation key number. Each label is unique.

Figure 1-2 shows where to apply the new label on the back of a TDS7000 series
oscilloscope.

Figure 1-3 shows where to apply the new label on the back of a TDS5000 series
oscilloscope.

TDSIJIT2 Jitter Analysis Application User Manual 1-3
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Figure 1-2: TDS7000 series oscilloscope label location
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Installing the Application

Normally, the TDSJIT2 application resides on the hard disk drive of your
oscilloscope. However, you may still need to install the application software for
the following reasons:

B You receive an application introduced after you received your oscilloscope

B You have to rebuild the hard drive

NOTE. To operate the TDSJIT2 application, the Java Run-time Environment
(JRE) V1.2.2 or above must be installed on your oscilloscope.

If the JRE is not installed, a message displays when you try to start the
application. If the message appears, reinstall the JRE from the optional
applications software for Windows-based oscilloscopes compact disc (CD).

1-4 TDSIJIT2 Jitter Analysis Application User Manual



Installation

From the Compact Disc  To install the TDSJIT2 application from the optional applications software for
Windows-based oscilloscopes CD, follow these steps:

1.

If the keyboard is not installed, connect it to the oscilloscope rear panel (the
optional-accessory keyboard plugs into the USB connector).

Power on the oscilloscope to start Windows.

Install the optional applications software CD in the CD-ROM reader on the
rear-panel of the oscilloscope.

Select the My Computer icon.
In the Exploring - My Computer window, select the D: (CD-ROM) drive.

The Java Run-time Environment software must be installed before you can
install optional application software. If the Java Run-time Environment
software is already installed, skip to step 7; otherwise, follow these steps:

a. Select the Jre directory.

b. Select the .exe file in the Jre directory.

c. Accept all default settings recommended by the install program.
Select the Tdsjit2 directory.

Select the Setup.exe file to start the install program.

Follow the instructions given by the install program. The oscilloscope must
reboot to complete the installation process.

From Floppy Disks  To install the TDSJIT2 application from floppy disk, follow these steps:

1.

2
3.
4

Power on the oscilloscope to start Windows.
Insert disk #1 in the floppy disk drive.
Select the My Computer icon.

In the Exploring - My Computer window, select the A: (3 1/2 Floppy) drive.

NOTE. Additional information about the application or installation is located in
a Readme.txt file on the floppy disk. Read the file before you continue.

If you are updating the application, the Readme.txt file on the Tektronix web site
supercedes the Readme.txt file on the floppy disk.

5.
6.

Select the Setup.exe file to start the install program.

Follow the on-screen instructions.

TDSIJIT2 Jitter Analysis Application User Manual 1-5
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Wait until after the floppy disk drive LED has gone out to remove each
floppy disk and insert another.

7. When the installation is complete, the oscilloscope will restart. You need to
remove the final floppy disk when prompted.

Enabling the Application

You will need to enter the authorized Option Installation Key to enable the
application. The key is specific to the serialized oscilloscope and options for
which it was purchased.

NOTE. Do not enter this key until all application software that you have
purchased has been installed.

To enter the key number, follow these steps:

1. If the oscilloscope powered on in the toolbar mode (default), select the Menu
button (upper right corner of the display) to put the oscilloscope into
menu-bar mode. In menu-bar mode you should see a PC-style menu across
the top of the display.

2. Go to the Utility menu in the menu bar and select Option Installation.

3. Follow the on-screen instructions to enter the alphanumeric key number
exactly as it is printed on the rear-panel label. Figure 1-2 on page 1-4
shows the location of the label on the back of the oscilloscope.

Deskewing the Probes and Channels

1-6

To ensure accurate results for two-channel measurements, it is important to first
deskew the probes and oscilloscope channels before you take measurements from
your system under test (SUT). Deskewing is where the oscilloscope adjusts the
relative delay between signals to accurately time correlate the displayed
waveforms.

NOTE. To produce good deskew results, you should connect the probes to the
fastest signal in your SUT.

The application includes an automated deskew utility that you can use to deskew
any pair of oscilloscope channels. The following procedure describes how to
deskew two channels. Channel 1 (and the probe connected to it) is the reference
point used to deskew channel 2. The steps to deskew the third and fourth
channels are the same.
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To deskew a pair of probes and oscilloscope channels, follow these steps:

1. Follow the procedure on page 1-9 to connect similar probes to CH1 and
CH2 on the oscilloscope.

2. Connect the probes to the fastest signal in your SUT.
3. Set up the oscilloscope as follows:

a. Use the Horizontal Scale knob to set the oscilloscope to an acquisition
rate so that there are two or more samples on the deskew edge.

b. Use the Vertical Scale and Position knobs to adjust the signals to fill the
display (view the full amplitude) without missing any part of the signals.

c. Set the Record Length so that there are more than 100 edges in the
acquisition.

Figure 1-4 shows an example of signal path skew found in similar probes.

File  Edit  Wertical Herizdfdeg  Trig Displapy Cuwrsors Measwe  Math Utlies  Help
Tek  Run Satrpla r?@

Cursl Pos
-400.0ps

Curs2 Pos

A 10.0ns &
R (e

Figure 1-4: Typical signal path skew

4. Start the application as described on page 2-33.

5. Select Inputs> Main > and set the Source to Ch 1. The Source waveform is
the reference point to which the remaining channels are deskewed.
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1-8

6. Select Inputs> 2nd> and set the Source to Ch 2, the channel to be deskewed.
7. To start the deskew utility, select Deskew and confirm the operation.

8. Select appropriate values in the Enter inputs menu, and then select OK.
Figure 1-5 shows the Enter inputs menu.

Egi Enter inputs

Enter the following values:

Max Range & Min Range J'

Oz Tus

[ 2

Figure 1-5: Enter inputs menu

The utility displays information as it deskews the channels, such as the
number of samples processed and specified. Figure 1-6 shows an example of
the utility when it is finished. In this example, the skew between channels 1
and 2 was reduced to about 57 ps.

File  Edit  Wertical Herizdfdeg  Trig Displapy Cuwrsors Measwe  Math Utlies  Help
Tek  Run Satrpla 2

Inputs: Znd

Main
Soeurez: Chi
Source Wertical Ref Levels igh: 1.0

G s Autosat 0.0V
Autazat utoze : 1o

2nd
Mid - Reset
hid: 0.0
Gualify Mode
Active:  Off =
Hysteresis valid;  High anglz W
Source: Refd

hlid: 0.0 .
Gating Qff

Figure 1-6: Deskew complete

TDSIJIT2 Jitter Analysis Application User Manual



Installation

9. Do not change the Input: Main channel, and deskew the remaining channels.

Connecting to a System Under Test

You can use any compatible probes to connect between your SUT (system under
test) and oscilloscope. One connection is usually to a clock signal.

The Clock-to-Data measurements and the Skew measurement require two input
channels or two reference waveforms.

Table 1-2 shows the default channel-to-waveform and reference waveform-to
plot assignments. You can change the assignments to match your configuration.

Table 1-2: Default waveform assignments

Channel or reference | Waveform assignment

Ch1 Main input waveform, such as a clock signal
Ch2 Second (2nd) input waveform

Reft Histogram plot format for the first measurement
Ref2 Time Trend plot format for the first measurement
Ref3 Cycle Trend plot format for the first measurement
Ref4 Spectrum plot format for the first measurement

WARNING. To avoid electric shock, you must ensure that power is removed from
the SUT before attaching probes to it. Do not touch exposed conductors except
with the properly rated probe tips. Refer to the probe manual for proper use.

Power down the SUT before connecting the probes to it.
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Basic Operations

This section contains information on the following topics and tasks:
®  Application interface

®m  Using basic oscilloscope functions

®m  Setting up the application

®  Taking measurements

B Warning messages

®  Analyzing the results

®m  Saving the results to a file

B Viewing a data log file

®m  Saving and recalling setups

®m  Exiting the application

Application Interface

The application uses a Windows type of interface. Figure 2-1 shows the Menu
bar and some of the buttons and boxes that you use to operate the application.

Menu bar—f& Measurements Inputs  Wiew Plot Log Help

Measurements: Select Active
Measurements Rea

dy
e C weeee - Clk-Drata - Clodk Period
Optlon Rize Time Fall Time Frequen

Wi dth Width Cyele-Cycle M-Cycle Data Period Hold
Crata TIE

Mode

. . P ozitive Megative
Low Time | ¢ oy, Cy-Cy D = .
Area Positive Hegative Single LISt bOX
Duty Cyele Dty Cycle =
Clear All Clodk TIE Command

button

Clock-Out

Figure 2-1: Application interface

NOTE. The oscilloscope application shrinks to half size and appears in the top
half of the display when the application is running.
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Table 2-1 lists the interface items with a brief description of each.

Table 2- 1: Application interface items

Item Description
Menu bar Located at the top of the application display and contains application menus
Area Visual frame that encloses a set of related options

Option button

Button that defines a particular command or task

List box Box that contains a list of items from which you can select one item

Box Box that you can use to type in text, or to enter a value with the Keypad or a
Multipurpose knob

Scroll bar Vertical or horizontal bar at the side or bottom of a display area that can be
used for moving around in that area

Browse Displays a window where you can look through a list of directories and files

Command button

Button that initiates an immediate action

NOTE. For a quick overview of the complete menu structure, refer to Figure 3-1
and Figure 3-2 starting on page 3-1.

Using Basic Oscilloscope Functions

2-2

Using Online Help

Minimizing and
Maximizing the
Application

You can use the Help menu to access information about the application. You can
also use other oscilloscope functions and easily return to the application.

The application includes Online Help about the application menus and controls.

To display the Online Help, follow these steps:

1. Choose the Help menu from the TDSJIT2 menu bar.

2. Use the Contents, TOC, or Index tabs to navigate through the help.

The application remains displayed when you minimize the oscilloscope. To
minimize the application, select Measurements> Minimize.

To maximize the application, select TDSJIT2 in the Windows toolbar.

TDSIJIT2 Jitter Analysis Application User Manual



Basics Operations

Returningtothe = When you access oscilloscope functions, the oscilloscope fills the display. You
Application  can access oscilloscope functions in the following ways:

®m  Select the Close button in the application display
B Choose the Menu-bar or Toolbar mode on the oscilloscope and access menus
B Press front-panel buttons

To return to the application, choose the App button. Figure 2-2 shows the App
button.

To return to the application, choose the App button

Fie  Edit “ertical Horiz/deq  Trg  Display  Cursors Measure  Math  Uiilities \_Help

Tek  Fun Sample 05 Jul 00 23:57:16

Figure 2-2: Returning to the application

Application Directories ~ The application uses directories to save and recall setup files and also uses
and File Names  extensions appended to file names to identify the file type.

Default Directories. Table 2-2 lists default directory names.

Table 2-2: Default directory names

Directory name Used for
C:\TekApplications\tdsjit2 Home location
C:\TekApplications\tdsjit2\log Data log files

C:\TekApplications\tdsjit2\setup Setup files

C:\TekApplications\tdsjit2\waveforms | Saved waveform files; can recall to reference memories

C:\TekApplications\tdsjit2\data Temporary measurement files

File Name Extensions. Table 2-3 lists file name extensions used or generated by
the application.

Table 2- 3: File name extensions

Extension Type
.Csv Log file that uses a “comma separated variable” format
.ini Application setup file
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Table 2- 3: File name extensions (Cont.)

Extension Type

.set Oscilloscope setup file saved and recalled with an .ini file; both files will
have the same name

wfm Waveform file that can be recalled into a reference memory

Setting Up the Application

Selecting a Measurement

You can set up the application to take up to six measurements at the same time.
In addition, you can plot the results in four formats, and save the statistical
results or worst case waveforms to a file to view later.

There are four Measurements menu items. One allows you to select measure-
ments, one allows you to configure a measurement, one allows you to save and
recall measurement setups, and one allows you to minimize the application.

To access the Select Active Measurements menu, go to the Measurements menu
in the menu bar and choose Select Measurement. Figure 2-3 shows the Select
Active Measurements menu.

% Measurements  [nputs Wiew Plot Log Help

Measurements: Select

Measurements

neral CheData~  [SEETLINIY E
Rize Time Fall Time Frequenay i Setup
Frequen

Prazitive Hegative .
Wi i Wi dth m pata Peried
Fositive Heqative Mode
Cy-Coy [ Cy-Cw [y
e Single
Fositive HNegative
Duty Cycle Duty Cycla

Figure 2-3: Select Active Measurements menu

NOTE. Choose the Clear All command button to remove all the measurements in
the list of Active Measurements.

Table 2-4 lists the measurements with a brief description of each.
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Table 2- 4: Select Active Measurements areas and options

Area Option Description
General Rise Time Elapsed time from when a rising edge crosses the low reference voltage level and then the
high reference voltage level
Fall Time Elapsed time from when a falling edge crosses the high reference voltage level and then the
low reference voltage level
Positive Width Amount of time a waveform remains above the mid reference voltage level
Negative Width Amount of time a waveform remains below the mid reference voltage level
High Time Amount of time a waveform remains above the high reference voltage level
Low Time Amount of time a waveform remains below the low reference voltage level
Clock Period* Elapsed time between consecutive crossings of the mid reference level by the waveform in
the specified direction; see the Common Cycle Start Edge option on page 2-6
Frequency* Inverse of the period for each clock cycle
Cycle-Cycle* Difference in period measurements from one cycle to the next
N-Cycle* Difference in elapsed time between two consecutive groups of N-cycles where N is a
configuration option number that you can set
Positive Cy-Cy Duty Difference between two consecutive positive widths
Negative Cy-Cy Duty | Difference between two consecutive negative widths
Positive Duty Cycle* Ratio of the positive portion of the cycle relative to the period
Negative Duty Cycle* | Ratio of the negative portion of the cycle relative to the period
TIE* Difference in time between the designated edge on a sampled clock waveform to the
designated edge on a calculated clock waveform with a constant frequency (zero jitter)
Data Data Period Elapsed time between when a waveform crosses a specific reference voltage level in the
same direction twice
Data Frequency Inverse of the period for each data cycle
Data TIE Difference in time between the data edges on a sampled data waveform to the data edges
on a calculated data waveform with a constant rate (zero jitter)
Clk-Data Setup Time* Elapsed time between when a data waveform crosses a voltage reference level followed by
the clock signal crossing its own voltage level
Hold Time* Elapsed time between when the clock waveform crosses a voltage reference level followed
by a data waveform crossing its own voltage level
Clock-Out Time* Elapsed time between when the clock waveform crosses a voltage reference level followed
by an output waveform crossing its own voltage level
Ch-Ch Skew* Difference in time between two “similar” edges on the Main and 2nd input waveforms with

the assumption that every edge in the Main waveform has a corresponding edge (either the
same or opposite polarity) in the 2nd waveform; edge locations are referenced to the mid
reference voltage level

*  Requires configuration.
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2-6

Configuring a
Measurement

Many measurements require configuration, as indicated in Table 2-4. To access
the Configure Measurements menu, go to the Measurements menu in the menu
bar and choose Configure.

NOTE. The Configure menu that displays is for the measurement selected in the
list of Active Measurements.

You do not need to configure the following measurements:

®m  General area (all): Rise Time, Fall Time, Positive Width, Negative Width,
High Time and Low Time

®  Clock area: Positive Cy-Cy Duty, and Negative Cy-Cy Duty
®  Data area (all): Data Frequency, Data Period, and Data TIE

Figure 2-4 shows the Configure Measurements menu for the General area
measurements.

% tMeasurements  Inputs Miew Plot Log Help

Measurements: Configure Active
Measurements

The selected measurement does not

have any configur ation parameters.
Maode

Single y

Figure 2- 4: General measurements configuration

Common Cycle Start Edge Option. The Common Cycle Start Edge option defines
which edge of the Main input is used to calculate all active clock-based
measurements.

Figure 2-5 shows the Common Cycle Start Edge configuration option used in
many measurements. This is the only configuration option for the following
Clock area measurements: Frequency, Period, Cycle-Cycle, Positive Duty Cycle,
Negative Duty Cycle, and TIE.
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%Measurements Inputs  “iew Plot Log Help

Measurements: Configure Active
Measurements

Re ady
start Edge ®

Mode

Single w7
blose

Figure 2-5: Common Cycle Start Edge option configuration

N-Cycle Configuration Options. Figure 2-6 shows configuration options for the
N-Cycle measurement.

% tMeasurements  Inputs Miew Plot Log Help

Measurements: Configure Active
Measurements

Common Cycle
Start Edge € Edge Increment
5 ®
|

Maode

Rise
15t Meas:

Single y

=

Figure 2-6: N-Cycle configuration options

Table 2-5 lists the configuration options for the N-Cycle measurement with a
brief description of each.

Table 2-5: N-Cycle configuration options

Option Description

N= Number of cycles in an N-cycle group

1st Meas: Start @ Number of cycles skipped prior to starting the measurement

Edge

Edge Increment Specifies whether consecutive measurements (each spanning 2N
cycles) jump forward one cycle (option 1) or N cycles in the waveform
(option N)
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Clk-Data Area Configuration Options. Figure 2-7 shows configuration options for
the Clk-Data area measurements.

% tMeasurements  Inputs Miew Plot Log Help

Measurements: Configure Active
Measurements

P Setup Tim=
Mazx. Value

Maode

- Min. Value Single hd

Figure 2-7: Clk-Data area configuration options

Table 2-6 lists the configuration options for the three Clk-Data measurements
with a brief description of each.

Table 2- 6: Clk-Data measurements configuration options

Option Description

Clock Edge Edge on the clock waveform used to take the measurement; you can
define the waveform in the Inputs: Main menu

Data Edge Edge on the data waveform used to take the measurement; you can
define the waveform in the Inputs: 2nd menu

Limit Range Specify the minimum and maximum range of valid measurement
values

Skew Configuration Options. Figure 2-8 shows configuration options for the
Skew measurement.

% tMeasurements  Inputs Miew Plot Log Help

Measurements: Configure Active
Measurements

To Edge

Mazx. Value
Same Tus
az From =

Maode
Min. Value Single hd

Op posite

az From
-1us

Figure 2-8: Skew configuration options
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Table 2-7 lists the configuration options for the Skew measurement with a brief
description of each.

Table 2-7: Skew configuration options

Option Description

From Edge Edge on the Main waveform used to take the measurement
To Edge Edge on the 2nd waveform used to take the measurement
Limit Range Same as Table 2-6

Specifying Inputs  The application takes measurements from waveforms specified as inputs.

NOTE. All General, Clock, and Data area measurements require a Main input.

All Data measurements require you to select the channel (reference memory or
math waveform) for the data signal as the Main Input Source.

All two-channel measurements that include a clock require you to select the
channel (reference memory or math waveform) for the clock signal as the Main
Input Source.

All Clk-Data and Ch-Ch area measurements require both a Main input and a
2nd input.

To access the Inputs: Main and Inputs: 2nd menus, go to the Inputs menu in the
menu bar and choose Main or 2nd. Figure 2-9 shows the Inputs: Main menu.

TDEJTZ
Jitter Analysis

% tMeasurements  Inputs Miew Plot Log Help

Inputs: Main Inputs Summary

Main Feady
Source: Chi

Source Wertizal Ref Levels High: 1.0%
Ch1 W Mid: o E
= Autozet Autoset o

Lo

2nd
Saurce: Chz
Mid:  0.0W

Qualify Mode
Active:  Off =
valid:  High Single
Source: Refd

hlid: 0.0 .
Gating Off

w

Figure 2-9: Inputs: Main menu

NOTE. The Inputs Summary shows the settings of all the Input menus.

TDSIJIT2 Jitter Analysis Application User Manual 2-9



Basics Operations

Table 2-8 lists the Inputs menus options with a brief description of each.

Table 2- 8: Inputs: Main and 2nd options

Option Description

Source* A “live” (channel), reference, or math waveform used as the signal or clock
source; all sources for the Main, 2nd, and Qualify inputs must have the
same Horizontal Sample Rate, Record Length, and Position to assure that
measurements function properly

Vertical Autoset | Changes the vertical scale and position for Ch 1, Ch 2, Ch 3, and Ch 4
waveforms so that they occupy the full vertical space available on the
display without any part of the waveform missing (clipped); uses 80% of the

Acquisitions ADC range
Ref Levels
Autoset Thresholds are set as a percentage of the voltage levels relative to the
minimum and maximum levels of the peak-to-peak values
Mid Where to set the middle threshold level on the slope, in volts; refer to

Figure 2-10

Hysteresis Threshold margin, in volts, relative to the reference level which the voltage
must cross to be recognized as changing; the margin is the voltage
reference level plus or minus half the hysteresis

High** Where on the slope, in volts, to set the high threshold level

Low** Where on the slope, in volts, to set the low threshold level

*  Only available for the waveform defined in the Inputs: Main menu.

*  For two-channel measurements that include a clock, select the channel (reference
memory or math waveform) for the clock signal as the Main Input Source. For Data
measurements, select the channel for the data signal as the Main Input Source.

Figure 2-10 shows how to determine the voltage reference levels.

AN LA AN
\ Vo
A
(R 5 L A B O WY AR
W) NN Y U

Inputs: Main reference levels Inputs: 2nd reference level

Figure 2-10: How to determine voltage reference levels
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NOTE. The application detects the minimum and maximum voltage levels of the
waveform. If the reference voltage level plus or minus the hysteresis falls outside
of 2.5% to 97.5% of the waveform peak-to-peak range, no measurement is taken.

Figure 2-11 shows the methods that you can use to enter Autoset Ref Level
values. The application displays this menu when you select Autoset in the

Inputs: Main, Inputs: 2nd, or Inputs: Qualify menus.

Autoset Ref Level

Multipurpose knob icon
Keypad icon

Hysteresis #
— *

- - pinmum velue bon
Ok Cancel .
Maximum value button

Figure 2-11: How to enter Autoset Ref Level values

Table 2-9 lists methods that you can use to enter values in the Autoset Ref Level

menu.

Table 2-9: Autoset Ref Level menu entry methods

Entry method Description

Keypad Icon appears when you select the box; select and use to enter a value

Multipurpose knob | When you select the multipurpose (MP) knob, a line appears between

the knob and the box; turn the knob on the oscilloscope to select a value

Figure 2-12 shows the Inputs: 2nd menu.
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2-12

Specifying Qualifiers

% tMeasurements  Inputs Miew Plot Log Help

Inputs: nd

Source ical Ref Levels

oo v

Mid Soeuree: ©h2
Mid: o.ow
Qualify Mode
Active:  Off
Hysteresis Valid:  High Sitg2
Source: Refd

(117
hlid: 0.0 .
Gating Off

w

Figure 2-12: Inputs: 2nd menu

Deskew Option. Starts the automatic deskew between the source designated as
the Main input and the source designated as the 2nd input. To perform the
deskew procedure, refer to Deskewing the Probes and Channels on page 1-6.

Qualifiers allow you to focus the application on more narrowly defined
conditions before taking measurements. This is one way to filter out information
that is not useful to analyze.

To access the Inputs: Qualify menu, go to the Inputs menu in the menu bar and
choose Quality. Figure 2-13 shows the Inputs: Quality menu.

% tMeasurements  Inputs Miew Plot Log Help

Inputs: Qualify

Ref Levels
Source

Ret: W Autozet

Mid Soeuree: ©h2
[LILH 0.ov

oy
Qualify Mode
Active:  Off
Hysteresis Valid:  High Sitg2
Source: Refd

(117
hlid: 0.0 .
Gating Off

Figure 2-13: Inputs: Qualify menu

Table 2-10 lists the Inputs: Qualify areas and options with a brief description of
each.
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Table 2- 10: Inputs: Qualify areas and options

Area Description

Source A “live” (channel), reference, or math waveform used to qualify the signal or
clock source; all sources for the Main, 2nd, and Qualify inputs must have the
same Horizontal Sample Rate, Record Length, and Position to assure that
measurements function properly

Ref Levels Same as the descriptions in Table 2-8 on page 2-10

State Specifies if the Qualifier option is enabled or not

True When | State condition is met when the qualifier is a logical low (0) or a logical high (1)

Figure 2-11 on page 2-11 shows the Autoset Ref Level menu. The application
also displays this menu when you select Autoset in the Qualify menu.

NOTE. The Qualifier Input and Gating functions are mutually exclusive. If you
enable both, the application displays an error message.

Specifying Gating/Other  Gating allows you to focus the application on a specific area of the waveform
bound by cursors before taking measurements. This is one way to filter out
information that is not useful to analyze.

To access the Inputs: Gating/Other menu, go to the Inputs menu in the menu bar
and choose Gating/Other. Figure 2-14 shows the Inputs: Gating/Other menu.

teasurements Inputs al=10 Plat Liog Help

Inputs: Gating ! Other

Acquisition Timeout

Huoriz Che " -1
Seurez Cha2

0.y

Gate w/ Cursors

TG L
.

Figure 2-14: Inputs: Gating/Other menu

Table 2-11 lists the Gating/Other options with a brief description of each.
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Table 2- 11: Inputs: Gating/Other options

Option

Description

Horiz Check

Checks if the Sample Rate is appropriate for the selected measurements;
accurate measurements require at least two samples per edge; for best
results, set the Horizontal Resolution on the oscilloscope to be as close as
but not greater than the following: Resolution < Min (rise time, fall time)/2.5,
where Rise and Fall are measured from 10% to 90%

Gate w/Cursors

Specifies if gating with cursors is enabled or not; use oscilloscope cursors to
define one specific part of the waveform on which to take measurements;
another type of qualifier

Acq Timeout

Sets an appropriate amount of time that the application will wait to acquire
data before it stops and displays an error message; Auto sets the timeout to
less than 0.1 hours; User allows you to enter a larger timeout value

Timeout

When User is selected, you can set the timeout from 0.1 hour to 24 hours

Taking Measurements

If you want to change trigger settings or localize the measurement, you should
do so before you take any measurements.

NOTE. If you select a reference or math waveform as the source, you will need to
recall and display the waveform before the application can take a measurement.
For information on how to do this, refer to Recalling a Waveform File on

page 2-32.

Remember to select Reset to set the results to zero if you change the oscilloscope
Vertical or Horizontal time settings between measurements.

Taking New  The Sequence Control menu is always accessible in the lower right part of the
Measurements  application display. Figure 2-15 shows the Sequence Control menu.

Start button

Reset button

Sequence Mode

Paused |

Stop button Continue
button

Pause button

Figure 2-15: Sequence Control menu
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To acquire data from waveforms, follow these steps:

1. Select a Sequence mode. See Table 2-12.

Table 2-12: Sequence Control menu

Option/button Description

Mode
Single If the input source is Ch1, Ch2, Ch3, or Ch4, the application acquires a new
waveform(s); for all sources, the application performs measurements on the
waveform(s) and stops
Free Run Repeatedly acquires the input waveform(s) and takes measurements;

disables the Time Trend, Cycle Trend, and Spectrum plots

Single No Acq | Performs measurements on the input waveform(s) and stops

Start/Continue Starts to take measurements from the input waveform(s)

button When paused, continues taking measurements

Pause button Pauses and resumes when you select the Continue button or stops when
you select the Stop button

Stop button Stops taking measurements

Reset button Resets all result values to zero

2. Press il to start the measurement sequence.

NOTE. Do not change oscilloscope settings while a measurement is being taken,
since this can cause an invalid measurement.

Localizing Measurements By specifying the trigger position, the starting point, and the length of the
waveform, you can effectively filter out information that is not useful to analyze
before taking a measurement.

To focus the application measurement on a part of the waveform, you can use the
Inputs: Gating menu. You can also adjust the Record Length, Scale or pretrigger

information in the oscilloscope Horizontal menu, or the trigger level and slope in
the Trigger menu.

NOTE. If an error message displays because there are not enough cycles from
which to take a measurement, you should increase the Horizontal Scale.
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Warning Messages

Analyzing the Results

The application displays and saves warning messages if the input conditions do
not support accurate measurements. You can view the accumulated messages in
the View Warnings menu. To access the View Warnings menu, go to the View
menu in the menu bar and choose Warnings.

Figure 2-16 shows the View Warnings menu with a message.

% tMeasurements  Inputs Miew Plot Log Help

View: Warnings

ES0S5:Clipping positive :Primary Input

Maode

Single y

Clearuiamings

Figure 2-16: View Warnings menu

To remove all of the messages, select Clear Warnings.

You can view the results as statistics or graphically as plots. Figure 2-17 shows
an example of the various results display formats.

NOTE. Stop the acquisition before viewing the results as plots if you are taking
measurements in the Free Run mode.
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Statistics readout Histogram plot
% Measurements [nputs Wiew Plot Log Help File Edt Wetical  Hoieddcq Trig  Displap  Cursors  Measure  Math  Utiities |

Time Trend plot Cycle Trend plot
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Spectrum plot
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Figure 2-17: Results as statistics and in four display formats

You can also log the data to a .csv file for viewing in a text editing, spreadsheet,
database, or data analysis program. Figure 2-18 shows an example of how a .csv
file might look in a spreadsheet program.

TOST2 Version ¥1.1.12 Tue Jul 17 16:11:50 POT 2001

Fiesult Type Cyele-Cyslefs) | Clock Dutjs) | Clack Period(s) | Clock TIE(s] | Setup Time{s] Clack Frequency(Hz) | Law Timels]
Fean 257E09 200E-08
Std Dew 1LT7E-10 2.39E-10
Fasimum 3.97E-09 2.06E-08
Felinimurm 3.19E-09 1.93E-08
Feak Peak TAIE-D 1.26E-09

Population 259 998
Foszitive Mean

Positive Max

Pasitive Papulation

Megative Mean

Megative Max

Megative Population

Estimated Frequency

Meazurement Results from Mozt Recent Acquisition

Serial Mumber Clock Period

2.02E-02
1.99E-0%
2.00E-02
Z.03E-08
2.03E-08

e re =

Figure 2-18: Example of viewing data in a .csv file
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Viewing Statistics

Viewing Plots

To access the View Results menu, go to the View menu in the menu bar and
choose Results. The application can display results for up to six measurements.
Figure 2-19 shows an example of the results for three measurements.

The statistical information that displays will vary by measurement. In general,
the View Results menu contains statistical values for the mean, the standard
deviation (StdDev), the peak-to-peak (Pk-Pk), the maximum (Max) and
minimum (Min) values, and the population (the number of samples used to
calculate the statistics).

% tMeasurements  Inputs Miew Plot Log Help

Figure 2-19: View Results menu, example of three measurements

You can graphically plot the results for easier analysis. There are four plot
formats: Histogram, Time Trend, Cycle Trend, and Spectrum. To access the
Select Plot menu, go to the Plot menu in the menu bar and choose Select.
Figure 2-20 shows the Select Plot menu.

&MEasurements Inputs  Wiew  Plot Log Help

Active Plot Type

e T i Select Ref Row in Table,

Change Measurement & Plot Type

Histogram .
Clock Period
- Ref wim Plot Assignments
D

Trend Ref  Type mert lish

;
Display

Trend
Mode

Spacum Zingle ha

Flose

Figure 2-20: Select Plot menu

The Ref Wfm Plot Assignments list shows each reference memory and the plot
format of the measurement stored in it. You can store one measurement in all
four formats.

TDSJIT?2 Jitter Analysis Application User Manual



Basics Operations

To configure a plot, change the following Select Plot options:

1. Select a reference memory in the Ref column of the table.

Select a measurement from the list of Active Measurements.

2
3. Select a plot option from the Plot Type area.
4

Select On for the Display option.

NOTE. If you change any of the plot parameters, the Display option is set to Off.

Table 2-13 lists the Select Plot areas and options with a brief description of each.

Table 2-13: Select Plot areas and options

Area/option

Description

Active Measurement

Lists the measurements activated in the Select Measurements menu

Plot Type

Histogram

Plots the results such that the horizontal axis represents the
measurement values and the vertical axis represents the number of
times that the value occurred

Time Trend*

Plots the results such that the vertical axis represents the measure-
ment value and the horizontal axis represents the time the measure-
ment occurred; the horizontal time span is the same as the input
waveform

Cycle Trend*

Plots the results such that the vertical axis represents the measure-
ment value and the horizontal axis represents the index number of the
measurement

Spectrum*

Plots the spectral content of the Time Trend plot where the vertical axis
represents jitter magnitude and the horizontal axis represents jitter
frequency

None

Clears the reference memory so that it is available for other uses

Display, On/Off

If On, displays the selected measurement in the specified plot format,
and stores it in the selected reference memory.

*  Plot is disabled when taking measurements in Free Run mode.

NOTE. You can select the same type of plot as long as the measurements are
different. If you set up two identical plot type and measurement combinations, an
error message displays.
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To access the Vertical/Horizontal Axis Plot menu, go to the Plots menu in the
menu bar and choose Vert/Horiz Axis. Figure 2-21 shows the Vert/Horiz Axis
menu for the Histogram plot.

% Measurements  [nputs Wiew Plot Log Help

Axis: Refl Plot
Vertical Horizontal Slact Plot

Max Height & Center & f Current Ref Uza

Ready
L Reset

Log 1= 1.000s

Mode
Rafrach Autoset
Single

Bin Resolution

3 e m

Figure 2-21: Vert/Horiz Axis Plot menu: Histogram plot

Table 2-14 lists the Vert/Horiz Axis Plot menu area and options for the
Histogram plot with a brief description of each.

Table 2- 14: Vert/Horiz Axis Plot options for Histogram plots

Areajoption Description
Vertical
Max. Height Maximum height of the plot in number of divisions
Scale Vertical axis is in logarithmic or in linear scale
Horizontal
Center Numeric value for the horizontal center position of the histogram
Span Numeric value for the total horizontal range of the histogram
Bin Resolution Resolution as defined by bins to be Coarse (20 bins), Medium
(100 bins), or Fine (500 bins)
Refresh Updates the plot with the latest Center and Span values entered
Autoset* Uses the results to determine logical values for the Center and Span
options if the population of the measurement is 3 or more, and redraws
the plot in the corresponding reference memory

*  You must make a measurement and plot the data before using the Autoset option.
The Horizontal area includes two readouts that display the following values:

B Min shows: Center - Span/2

®  Max shows: Center + Span/2
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Figure 2-22 shows the Vert/Horiz Axis Plot menu for the Time Trend plot.

% Measurements  [nputs Wiew Plot Log Help

Axis: Ref2 Plot Select Plot

Vertical Current Ref Use

Max Height ¥ Meas

D s *

Mode

Single

Figure 2-22: Vert/Horiz Axis Plot menu: Time Trend plot

Table 2-15 lists the Vert/Horiz Axis Plot menu option for the Time Trend plot
with a brief description.

Table 2- 15: Vert/Horiz Axis Plot option for Time Trend plots

Option Description

Vertical Max. Height | Maximum height of the plot in number of divisions

Figure 2-23 shows the Vert/Horiz Axis Plot menu for the Cycle Trend plot.

% Measurements  [nputs Wiew Plot Log Help

Axis: Ref3 Plot Select Plot

Current Ref Use
Wertical Horizontal

Max Height & Length L Uge Meas

L L

Aivs S00P4

C;rc:le Trend |Glock Period

Figure 2-23: Vert/Horiz Axis Plot menu: Cycle Trend plot
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Table 2-16 lists the Vert/Horiz Axis Plot menu options for the Cycle Trend plot
with a brief description of each.

Table 2- 16: Vert/Horiz Axis Plot options for Cycle Trend plots

Option Description

Vertical Max. Height | Maximum height of the plot in number of divisions

Horizontal Length Length of the plot in number of record points

Figure 2-24 shows the Vert/Horiz Axis Plot menu for the Spectrum plot.

% Measurerents  Inputs  Wiew FPlot Log Help =

S itter

Axis: RefdPlot Salact Plot
Window Data

Vertical Current Ref Use

Ready

|
Reset (0

Max Height #
- Mode

A0 iws
Single b

°'°°“P*“°d - m

Exit

Figure 2-24: Vert/Horiz Axis Plot menu: Spectrum plot

Table 2-17 lists the Vert/Horiz Axis Plot menu options for the Spectrum plot
with a brief description of each.

Table 2-17: Vert/Horiz Axis Plot options for Spectrum plots

Parameter Description
Vertical
Scale Vertical axis is in dB or linear scale
Max. Height Maximum height of the plot in number of divisions
Window Data Reduces spectral leakage in the Fast Fourier Transform (FFT) waveform;
a Hanning window (raised cosine) on the Time Trend data

TDSJIT?2 Jitter Analysis Application User Manual



Basics Operations

Clearing Results

To reset the results to zero, choose the Reset button in the Sequence Control
menu. You do not have to wait for a measurement to complete to clear the
results.

Saving the Results to a File

Logging Statistics

You can save the results for all active measurements as statistics to a data log file
or save the worst case waveforms to waveform files.

This type of logging saves the statistical results of all activated measurements
and the individual result points for the measurement at the top of the list to a data
log file. To access the Statistics Log menu, go to the Log menu in the menu bar
and choose Statistics.

Figure 2-25 shows the Log: Statistics menu.
% tMeasurements  Inputs Miew Plot Log Help
Log: Statistice

Loagi
e Log File Hame

Save
Clear Maode
Current

Single

Figure 2-25: Log: Statistics menu

Table 2-18 lists the Log: Statistics options and buttons with a brief description
of each.

Table 2-18: Log: Statistics options and buttons

Option/button Description

Logging Enables the application to save the statistical results for all active
measurements, as well as the individual results to a data log file

Clear Clears the data log file; you must disable the logging before you can
clear the contents of the data log file

Save Current Stores the current measurement results in a “comma separated
variable” formatted file (.csv file) that you can view at a later time

Log File Name: Allows you to select the directory in which to save the data log file and

Browse to enter a name for the file; the extension must be .csv
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Data Log File Format

Logging Min/Max
Waveforms

Figure 2-26 shows an example of the Log file directory that displays when you
select Browse.

Figure 2-26: Log file directory

The data log file consists of one header row and rows of logged information. The
header row contains the application name, the version number of the application,
and the date and time on which the file was created. The next set of rows contain
statistical information from the last acquisition for all activated measurements
and the individual result points for the measurement at the top of the list.

Figure 2-18 on page 2-17 shows a formatted .csv file.

NOTE. If you are using a GPIB program to execute the application, such as in
automated test environments, you can add your own annotation through the
logAnnotate GPIB command. You can add information consisting of up to 20
characters; the custom information will appear as the last column in the
individual result records of that acquisition.

This type of logging saves the acquired waveforms where the minimum and
maximum worst cases occur. When enabled, the waveforms are saved to a set of
.wim files.

To access the Log Min/Max Wfm menu, go to the Log menu in the menu bar and
choose Min/Max Wfm. Figure 2-27 shows the Log Min/Max Wfm menu.
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% tMeasurements  Inputs Miew Plot Log Help

Log: Min/Max wifim Active
Measurements

Saving Select Directory

Clowk Period
RO

Waveform file names for the highlighted measurement

Mode

Singls w7

blose

Figure 2-27: Log: Min/Max Wfm menu

NOTE. File names for the waveforms are unique to each measurement. The
application displays the file names when you select an active measurement
although worst case waveforms are saved for all active measurements.

The Minl and Maxl waveform files are for the Main input and the Min2 and
Max2 waveform files are for the 2nd input.

Table 2-19 lists the Log Min/Max Wfm options with a brief description of each.

Table 2-19: Log Min/Max Wfm options and buttons

Option/button Description

Active Measurements Lists the measurements activated in the Select Measurement
menu; the application can save the worst case waveforms for all
measurement from this list

Saving Enables the application to save the minimum and maximum worst
cases to waveform files

Select Directory: Browse | Allows you to select a directory in which to save the worst case
waveform files

Table 2-20 lists the file names of the minimum and maximum worst case
waveforms for various measurements.
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Table 2-20: File names for Min/Max waveforms

Measurement Min waveform Max waveform
Rise Time RISEMin1.wfm RISEMax1.wfm
Fall Time FALLMin1.wfm FALLMax1.wfm
Positive Width PWMin1.wfm PWMax1.wfm
Negative Width NWMin1.wfm NWMax1.wfm
High Time HIGHMin1.wfm HIGHMax1.wfm
Low Time LOWMin1.wfm LOWMax1.wfm
Frequency CFMin1.wfm CFMax1.wfm
Period CPMin1.wfm CPMax1.wfm
Cycle-Cycle CCPMin1.wfm CCPMax1.wfm
N-Cycle NCPMin1.wfm NCPMax1.wfm
Positive Cy-Cy Duty PCCDMin1.wfm PCCDMax1.wfm
Negative Cy-Cy Duty NCCDMin1.wfm NCCDMax1.wfm
Positive Duty Cycle PDCMin1.wfm PDCMax1.wfm
Negative Duty Cycle NDCMin1.wfm NDCMax1.wfm
TIE TIEMin1.wfm TIEMax1.wfm
Data Frequency DFMin1.wfm DFMax1.wfm
Data Period DPMin1.wfm DPMax1.wfm
Data TIE DTIEMin1.wfm DTIEMax1.wfm
Setup Time SUMin1.wfm SUMax1.wfm
SUMin2.wfm SUMax2.wfm
Hold Time HOLDMin1.wfm HOLDMax1.wfm
HOLDMin2.wfm HOLDMax2.wfm
Clock-Out Time TCOMin1.wfm TCOMax1.wfm
TCOMin2.wfm TCOMax2.wfm
Skew Time SKEWMin1.wfm SKEWMax1.wfm
SKEWMin2.wfm SKEWMax2.wfm
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Viewing a Data Log File

You can view the .csv data log file (comma separated variable format) in a text
editing, spreadsheet, database, or data analysis program for further analysis.

NOTE. You can use Notepad or Wordpad to quickly view the results in the data
log file.

If you take different measurements and store them in one data log file, you can
group the measurements by sorting them in a program on a personal computer.
Figure 2-18 on page 2-17 shows an example of an edited .csv file in a spread-
sheet program.

Saving and Recalling Setups

You can use the Save/Recall Measurements menu to save and recall different
configuration setups. To access the Save/Recall Measurements menu, go to the
Measurements menu in the menu bar and choose Save/Recall.

Figure 2-28 shows the Save/Recall Measurements menu.

% tMeasurements  Inputs Miew Plot Log Help

Measurements: Save ¥ Recall Active
Measurements

Clodk Peried
Select file name to save into: - .

Select file name to recall from;: Recall...
Reset

Maode
Recall default values: File name for SaveRecall:

Single y
Default CATekApplicationsit pleetup.ini
blose

Figure 2-28: Save/Recall Measurements menu

Table 2-21 lists the Save/Recall Measurements options with a brief description
of each.
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Table 2-21: Save/Recall Measurements options

Option Description

Save Allows you to select a file in which to save the application setup
Recall Allows you to select a file from which to recall the application setup
Default Recalls the Default application setup values

File name for Save/Recall | Displays the name of the last file used to save or recall a setup

NOTE. The Measurements > Save/Recall function includes the settings of the
oscilloscope application. When you exit the application, you can choose whether
to restore the settings of the oscilloscope to those present before starting the
application.

Do not edit the .ini or the .set files, or recall setup files not generated by the
application, since this can cause the application to become unstable.

Saving a Setup  To save the application and oscilloscope settings to a file, follow these steps:
1. Select Measurements > Save/Recall.

2. Select the Save button. Figure 2-29 shows an example of how the directory
displays when you select the Save button.

[%i Select file to Save

Files of type: Al ini Files(.iniy) e

Figure 2-29: Save directory
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3. Select the directory in which the setup file will be saved.

4. Select or enter a file name. The application appends an .ini extension to the
name of setup files.

5. Choose Save.

NOTE. The application also saves the oscilloscope setup to a .set file when you
save an application setup. Both the application .ini file and oscilloscope .set file
have the same file name.

Recalling a Saved Setup  To recall the application and oscilloscope settings from a saved setup file, follow
these steps:

1. Select Measurements > Save/Recall.

2. Select the Recall button. Figure 2-30 shows an example of how the directory
displays when you select the Recall button.

Files of type: Al ini Files (.ini) -

Figure 2- 30: Recall directory

3. Select the directory from which the setup file will be recalled.
4. Select or enter a setup file name.

5. Choose Recall.

TDSJIT2 Jitter Analysis Application User Manual 2-29



Basics Operations

Exiting the Application

2-30

Recalling the Default
Setup

NOTE. The application also recalls the oscilloscope setup from a .set file when
you recall an application setup.

To recall the application settings from the Default setup file, follow these steps:
1. Select Measurements > Save/Recall.

2. Choose Recall default values.

To exit the application, choose Exit. When you exit the application, you can
select to keep the oscilloscope setup currently in use with the application or to
restore the oscilloscope setup that was present before you started the application.
Figure 2-31 shows the Exit menu.

i Exit EEExit

Restore oscilloscope
setup option

Exit the Application™ Exit the Application’?

Figure 2-31: Exit menu
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This tutorial teaches you how to set up the application, take two types of
measurements, and view the results. Further operating information is located in
the Operating Basics section.

Before you begin the tutorial, you must do the following tasks:
®m  Set up the oscilloscope
m  Start the application

m  Recall the tutorial waveforms

NOTE. Figures that show the display of an oscilloscope are from a TDS7104;
there may be minor differences if you work through this tutorial with another
type of oscilloscope.

Setting Up the Oscilloscope
To set up the oscilloscope, follow these steps:

1. Go to the File menu in the menu bar and select Recall Default Setup to set
the oscilloscope to the default factory settings.

2. Press the individual CH 1, CH 2, CH 3, and CH 4 buttons as needed to
remove active waveforms from the display.

Starting the Application

To start the application, go to the File menu in the menu bar and select Run
Application> Jitter Analysis 2. The application starts up and displays as shown
in Figure 2-32.
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% Measurements  [nputs Wiew Plot Log Help

Measurements: Select Active
Measurements

Clle [ ata - Clack Period

-
f f f Data

Rize Time Fall Time Frequenay Ferind Frequen Setup

ok
Prazitive Hegative .
Wi i Wi dth m pata Feriad
Fuositive HMegative
Cy-Cy Dy C-Cw [y
Fositive HNegative
Duty Cycle Duty Cycla

Clear All Clock TIE

Figure 2- 32: Starting the application

Recalling a Waveform File

The application includes waveform files for use with this tutorial. Table 2-22
shows the types of signals that these waveforms represent.

Table 2-22: Waveforms and signal types

Waveform name Signal type
jit2_clk.wim A clock signal
jit2_data.wifm A data signal

To recall waveforms to Ref2 and Ref3 on the oscilloscope, follow these steps:

1. Go to the File menu in the oscilloscope menu bar and access Reference
Waveforms> Reference Setup. Figure 2-33 shows the Ref tabs.

Save Wim to Ref? Recall Ref2 from File
P

d-‘ -
m D Recall

1.0% L Save WEm to File Delete \Wfm File

e By
a2 z = ¥ [ow
Horz Pos

E0.0% Clase

Position y.
0.0

Scale -

Label

Figure 2- 33: Oscilloscope reference memory setup
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2. Select the Ref2 tab and Recall. Choose the c:\TekApplications\tdsjit2\wave-
forms directory. Figure 2-34 shows a list of waveform files that appear.

Recall Reference Waveform |

Loak im; I@waveforms ﬂ @I gl

jitz_dat.wim

File name: — [iit2_clk, wim Fiecal |
Files of ope: IWaveform Files [ wim) LI Cancel |

Open K eyboard | Help |

Figure 2- 34: Waveform directory and files

Select the jit2_clk.wfm file and Recall.
Select the Ref3 tab and Recall.
Select the jit2_data.wfm file and Recall.

Select Display Off for Ref3.

NS W

To return to the application, choose the App button in the Menu bar.

Taking a Clock Period Measurement

In this example, you will learn how to use the application to take a Clock Period
measurement, how to view the results as statistics, and how to view the results in
the various plot formats. To perform these lessons, the application must be
installed and enabled on the oscilloscope. See Installation on page 1-3.

To take a Clock Period measurement, follow these steps:

1. To set the application to default values, select Measurements> Save/Recall>
Default.

2. Select Inputs> Main> Source> Ref 2.

3. Select Ref Levels Autoset. Figure 2-35 shows the Autoset Ref Level menu.
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Autoset Ref Level

Figure 2- 35: Autoset Ref Level menu
4. Select OK. Figure 2-36 shows the Inputs: Main menu setup.

% Measurements  [nputs Wiew Plot Log Help

Inpurts: Main Inputs Summany
Main
Source: Ref?
Source Wartic, Ref Levels High: 230my

Ref2 W hdid: -24my
Autoset Autoset Lo B78mY

- - 2nd
Mid L Source: Ref2

2am L Mid:  0.0u

Hysteresis id:  High

B S 2 Source: Ref3

Mid: 00w :
Gating Off

Figure 2- 36: Inputs: Main menu setup

5. Press *| to start the acquisition as shown in Figure 2-37.

Start button

Single mode

Figure 2-37: Taking a measurement

Figure 2-38 shows the statistical results.
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% tMeasurements  Inputs  Miew Plot Log Help

Single

Figure 2-38: Clock Period lesson: statistical results

6. To view the results as a Histogram plot, select Plot> Select> Histogram
(button)> Display> On. Figure 2-20 on page 2-18 shows the default for a
Histogram plot of the Clock Period measurement to display as Refl.

7. To view any of the plots, you need to remove the Ref2 waveform from the
display. In the oscilloscope menu bar, go to File> Reference Waveforms>
Reference Setup> Ref2> Display> Off.

Figure 2-39 shows the Histogram plot. It initially displays as a single bar.

File  Edit  Wertical Herizdfdeg  Trig Displapy Cuwrsors Measwe  Math Utlies  Help
Tek  Ruh Satnple 30 0ck 00 @\ r‘@
Ref2 Position
0. 0ddiv

Ref2 Scale

Imy

4.Onziot

Save Wim to Ref2 Recall Ref2 from File

S
-
E Fesall
Save Wim to File Delete Wim File

~JE B

Display Position ['

oodm 1%

Scale

a00.0mY

Horz Pos
50

Figure 2-39: Clock Period lesson: Histogram plot

8. To return to the application, choose the App button in the Menu bar.

TDSJIT?2 Jitter Analysis Application User Manual 2-35



Tutorial

9. To view the plot using logical Center and Span values, select Plot>
Vert/Horiz Axis> Horizontal> Autoset. Figure 2-40 shows the Histogram
plot automatically redrawn by the application.

File  Edit  “ertical Horizftcg  Trg  Display  Cursors MeazLne Math Utilities Help

19 Jun 07 15:24; F@

Ref2 Position

L

Fefl  12.hit.
£ Measurements Inputs Yisw Plot Log Help

Axis: Refd Plot
Vertical Horizontal

Max Height Center # Min

20ns e 19.01n= Ref wifm Plot Assignments ﬂ
® : et Type Il mert  Disp
(]

Select Ref Row in Table,
Change Measurement & Plot Type

Histogram Clock Period

nong Clodk Feriod
= _ nens Clodk Peried
Bin Resolution

Figure 2-40: Plot after using Horizontal Autoset in the Vert/Horiz Axis menu

10. Select Plot> Select.

11. To view the results as a Time Trend plot, select Time Trend> Display> On.
Figure 2-41 shows the Time Trend plot.
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File  Edit  “ertical Huoriz g

€0 Measurements

Active Plot Type

Measurement s

Clock Feriod

Histagram

Tima
Trend
Cyyele
Trend

Spectrum

Trg  Dizplay

Dizplay

LCurzors MeazLne Math Utilities

Select Ref Row in Table,
Change Measurement & Plot Type

Ref wim Plot Assignments
=LFEment

Time Trend |Clode Period

nong Clodk Feriod

nens Clodk Peried

nong Clodk Feriod

Figure 2-41: Clock Period lesson: Time Trend plot

Help

Ref2 Position

12. To view the results as a Cycle Trend plot, select Cycle Trend> Display> On.
Figure 2-42 shows the Cycle Trend plot.

File  Edit  “ertical Huoriz g

Trg  Dizplay

MeazLne Math Utilities

18 Jun 07 14

LCurzors

Figure 2-42: Clock Period lesson: Cycle Trend plot

Help

Ref2 Position

13. To view the results as a Spectrum plot, select Spectrum> Display> On.
Figure 2-43 shows the Spectrum plot.
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File  Edit  Wertical Herizdfdeg  Trig Displapy Cuwrsors Measwe  Math Utlies  Help

Tek I I [=F :: , . } . , a0 Moy [ : -Euttnns
. . : , : + : : : : 1 Ref1 Position

Ref1 Scale

20.0ps

Figure 2-43: Clock Period lesson: Spectrum plot

Taking a Clock-to-Output Time Measurement

In this example, you will learn how to use the application to take two measure-
ments at the same time: Clock-to-Output Time and Clock Period. You will need
two waveforms to take a Clock-Out measurement.

Retain the Input: Main setup for Ref2 from the previous lesson. That waveform
will be used in both measurements.

To set up the application to take a Clock Out Time measurement, follow these
steps:

1. You need to remove the Spectrum plot from the display. In the oscilloscope
menu bar, go to File> Reference Waveforms> Reference Setup> Ref1>
Display> Off.

2. You need to redisplay the jit2_clk.wfm file recalled to Ref 2. To do this,
select Ref2> Display> On.

3. You also need to display the jit2_data.wifm file recalled to Ref 3. To do this,
select Ref3> Display> On.

To return to the application, choose the App button in the Menu bar.
Select Measurements> Select> Clock-Out in the Clk-Data group.
In the Active Measurements list, select Clock-Out.

Select Inputs> 2nd> Source> Ref 3.

® XS e

Select Ref Levels Autoset and OK. Figure 2-44 shows the Inputs:2nd menu
setup.
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% Measurements  Inputs

Inputs: nd

Source L al

- =

“iew Plot Log Help

Ref Levels
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Figure 2-44: Inputs: 2nd menu setup
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9. Select Reset to reset any previous results to zero as shown in Figure 2-45.

Reset button

Sequence Mode

Figure 2-45: Resetting the results

10. Press *| to start the acquisition. Figure 2-38 shows the statistical results.

% tMeasurements  Inputs Miew Plot Log Help

T

Clock P | Clock- Ot |

Wean 0

1r

Jitter Anahy:

Ready

ElE

Figure 2-46: Clock-to-Output lesson: statistical results
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Saving the Results to a Data Log File
To save the measurement results to a data log file, follow these steps:

1. Go to the Log menu in the menu bar and select Statistics. Figure 2-47 shows
an example of the default application directory and log file name.

% tMeasurements  Inputs Miew Plot Log Help

Log: Statistice

Logging LA

ChTekApplication

Save
Clear Maode
Current

Single

Figure 2-47: Log Statistics menu with default file name

2. Select Logging On.
3. Press *| to start the acquisition.

4. After the measurement completes, press *| to log more data to the
results.csv file.

5. Select Logging Off before viewing the data log file.

6. Exit the application.

Viewing a Data Log File

To view the data log file in a text editing application, such as Wordpad, follow
these steps:

1. From the tool bar, select Start icon> Programs> Accessories> Wordpad.
2. Select File> Open.

3. Locate the C:\TekApplications\tdsjit2\log directory.

4. Select All Documents (*.*) for the Files of Type.

Figure 2-48 shows the directory and log file with the default name.
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Figure 2-48: Log file with default file name

5. Select the results.csv file and Open. Figure 2-49 shows the .csv file viewed

in Wordpad.

=] ..csv - WordPad
File Edit Yiew Inset Fomat Help

D E| Slal sl & 5w | )

hDSJITZ,VErSiDn Wi.1.153,Tue Jul 17 15:11:50 PDT zZ001

Result Type, Cycle-Cycle(s), Hold Time(s), Negatiwve Widthis),

Meal, vryrorrre 3-06T1E-9, o, 20.000E=3,

Std Dev, srrrreres 176.93E-12, ,,,,,,238.83E-12,,,,,,+
Maxirim, , ;, vr6 56 r3.9699E-9, , ,,,,,20.600E-9, ,,,,,,
Minitontty ;opprrrsr 30 L8TIE-0, v 0 r o 18 343E-"F, v s s s iy
Peak Peak,,  rrvreres 82.57E-12,, 0, 1.8572E-9, ;s s s+
Population, ;;vvevver259.00,, ,,,,,9958.00, ...,

Positive
Positive
Positive
Negative
Hegat ive
Negat ive

MERN, s ssvrrrvrvrmernsrarrars
MAX, s srrrrrovrenrrsiiarsvs
POPULALION, s rvsmrrrrrarsvrrrrrirs
MERN, ;ssvrrrvrvrmvrnsrarrars
MM, s vvvvrrvvrrrencrnsivicis

POPULACiON, s rssmsrmrruarrvrriisirs

Eztimated FreqUeney, . cvrmrrnrrvrrvranrrirs

Nesaurement Resulta frow Most Recent leguiszition

Berial Muwber, Clock Period

Fall Time(s), Positive Duty Cyclei%) .,

1,z0.
z,19.
3,19,
4,20.
5, 20.
fi,19.

175E-9
S70E-9
97SE-2
Z54E-9
JEZ0E-9
670E-9

7,19.554E-9

For Help. press F1

Figure 2-49: results.csv file viewed in Wordpad
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You can also import the .csv file to a DOS-based personal computer and then
view the data log file with a spreadsheet, database, or data analysis program.

Stopping the Tutorial

If you need more than one session to complete the tutorial lessons, you can stop
the tutorial and return to it another time.

To save the application setup and stop your session, refer to Saving a Setup on
page 2-28 and to Exiting the Application on page 2-30.

Returning to the Tutorial

To return to the tutorial setup, you can start the application and then recall the
saved setup. To recall the application setup, refer to Recalling a Saved Setup on
page 2-29.
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GPIB Program Example

This section contains an example of a GPIB program that can execute the
TDSIJIT?2 application. The oscilloscope hard disk and the optional applications
compact disc both contain this program in the tdsjit2ctrl.c file. The file resides
on the hard drive in the C:\Program Files\TekApplications\tdsjit2 directory.

Guidelines

Your GPIB program should comply with the following guidelines:

Program Example

The application startup must complete before sending additional GPIB
commands to the application (see example).

The measurements cycle must complete before data is queried (see example).

The error variable should be checked to ensure that an error has not occurred
because of a measurement command problem.

This example shows how a GPIB program might execute the application to do
the following tasks:

Start the application
Recall a setup
Enable the logger
Take a measurement
Check for an error

Exit the application

Refer to Appendix B: GPIB Command Syntax for a complete list of the GPIB
command syntax with the arguments, variables, and variable values.

NOTE. GPIB commands are case and space sensitive.
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/* TDSJIT2
* This is a reference program to illustrate how to communicate to TDSJIT2
* using Remote GPIB facilities.

Typical Application does following steps

. Start up the application
Recall a setup

Take a measurement
Display results or errors
Exit the application

ool BN

For the current program, we will recall "Default" settings (This has only one active
measurement - Clock Period).

You can save setup files according to your own needs using the GUI based interface of
the application.

*/

#ifdef _ cplusplus
extern "C"{

#endif

#include <windows.h>
#include <stdio.h>
#include <stdlib.h>
#include "decl-32.h"
#ifdef _ cplusplus

}

#endif

/* Forward Declarations */

int start application(int scope);

int exit_application(int scope);

int do_single test (int scope);

int recall setup( int scope, char *filename);
void display results(int scope);

// parameters needed to access the device driver handler
#define BDINDEX 0 // Board Index

#define PRIMARY_ADDR_OF DMM 1 // Primary address of device
#define NO_SECONDARY_ADDR 0 // Secondary address of device

#define TIMEOUT T10s // Timeout value = 10 seconds
#define EOTMODE 1 // Enable the END message
#define EOSMODE 0 // Disable the EOS mode
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//char ReadBuffer[100]; // Read data buffer

char ErrorMnemonic[21][5] = {"EDVR", "ECIC", "ENOL", "EADR", "EARG",
IIESACII’ IIEABOII’ IIENEBII’ IIEDMAII’ IIII’
IIEOIPII’ IIECAPII’ IIEFSOII’ IIII’ IIEBUSII’
IIESTBII’ IIESRQII’ IIII’ IIII’ IIII’ IIETABII};

/*
* After each GPIB call, the application checks whether the call
* succeeded. If an NI-488.2 call fails, the GPIB driver sets the
* corresponding bit in the global status variable. If the call
* failed, this procedure prints an error message, takes
* the device offline and exits.
*
/
void GPIBCleanup(int ud, char* ErrorMsg)
{

printf("Error : %s\nibsta = 0x%x iberr = %d (%s)\n",
ErrorMsg, ibsta, iberr, ErrorMnemonic[iberr]);
if (ud !'= -1)
{
printf("Cleanup: Taking device offline\n");
ibonl(ud, 0);
}
exit(0);

/* Start Jitter Analysis application */

int start_application( int scope ) {
char write buffer[100];
char read buffer[100];
char app_name[] = "\"TDSJIT2\"\n";
int status, timer;

/* Start the application */
sprintf(write_buffer, "%s", "Application:activate \"Jitter Analysis 2\"");
status = ibwrt(scope, write buffer, strlen(write buffer));

if (ibsta & ERR){

GPIBCleanup(scope, "Unable to start the application");
return 0;

}

timer = 1;

while (1) {
// Check whether application has started
sprintf(write_buffer, "%s", "Variable:value? \"application\"");
status = ibwrt(scope, write buffer, strlen(write buffer));
status = ibrd(scope, read buffer, sizeof(read buffer));
read buffer[ibcnt] = '\0';
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if (strcmp(app_name, read buffer) == 0) {
return 1;
}

timer++;
if (timer > 60) {
return 0;

}

Sleep(1000);
}

return 1;

}

int exit _application(int scope) {
char write buffer[100];

printf("Exit Application ...\n");
sprintf(write_buffer, "%s", "Variable:value \"application\",\"exit\"");
ibwrt(scope, write buffer, strlen(write buffer));

return 1;

}

int recall setup(int scope, char* filename) {

char write buffer[100];
char readBuffer[100];
int status;

int timer;

/* Change to Default Directory - From GPIB we can access setup files only in this
directory */

sprintf(write_buffer, "%s", "Variable:value \"setupDirectory\",\"Default\"");
status = ibwrt(scope, write buffer, strlen(write buffer));

if (ibsta & ERR){

GPIBCleanup(scope, "Unable to communicate with Scope");
return 0;

}

/* set Recall file name */
sprintf(write_buffer, "%s%s%s", "Variable:value \"recallName\",\"", filename, "\"");
status = ibwrt(scope, write buffer, strlen(write buffer));

if (ibsta & ERR){

GPIBCleanup(scope, "Unable to communicate with Scope");
return 0;
}
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/* recall setup */

sprintf(write_buffer, "%s", "Variable:value \"setup\",\"Recall\"");

status = ibwrt(scope, write buffer, strlen(write buffer));

if (ibsta & ERR){
GPIBCleanup(scope, "Unable to communicate with Scope");
return 0;

}

/* Check whether recall is complete or not...If recall is complete

variable setup value will change to a blank string */
timer = 1;

while (1) {
if (timer > 60) {

return 0;

}

sprintf(write_buffer, "%s", "Variable:value? \"setup\"");

ibwrt(scope, write buffer, strlen(write buffer));
/* read the answer */
ibrd(scope, readBuffer, 99);

if (ibsta & ERR) {
GPIBCleanup(scope, "Unable to write to device");

}

readBuffer[ibcnt] = '\0';

if (strcmp(readBuffer,"\" \"\n") == 0) {
return 1;

}

Sleep(1000);

}

return 1;

int do_single test (int scope){
char write buffer[100];
char read buffer[100];

int timer;

sprintf(write_buffer, "%s", "Variable:value \"sequencerState\",\"Sequencing\"");

ibwrt(scope, write buffer, strlen(write buffer));

printf("Executing Test...\n");
Sleep(100);
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// Wait for application to come to Ready State
timer = 1;

while (1) {

if (timer > 90) {
printf("******Test Time Qut ******\n");
return 0;

}

sprintf(write_buffer, "%s", "Variable:value? \"sequencerState\"");
ibwrt(scope, write buffer, strlen(write buffer));

/* read the answer */

ibrd(scope, read buffer, 99);

if (ibsta & ERR) {
GPIBCleanup(scope, "Unable to write to device");

}

read buffer[ibcnt] = '\0';

if (strcmp(read buffer,"\"Ready\"\n") == 0) {
printf("Test Complete ...\n");

return 1;

}

Sleep(1000);

}

void display results(int scope) {

char write buffer[100];
char read buffer[100];

// Check for errors
sprintf(write_buffer, "%s", "Variable:value? \"error\"");
ibwrt(scope, write buffer, strlen(write buffer));

/* read the answer */
ibrd(scope, read buffer, 99);

if (ibsta & ERR) {
GPIBCleanup(scope, "Unable to write to device");
}

read_buffer[ibcnt] = '\0';
if (strcmp(read buffer,"\" \"\n") !=0) {

printf("Error has Occured. Error: %s\n",read buffer);
return;

}
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// If no error, check for results
sprintf(write_buffer, "%s", "Variable:value \"resultFor\",\"CP\"");
ibwrt(scope, write buffer, strlen(write buffer));

Sleep(2000);

printf("\tClock Period Results\n");

// *kkkkkk* Mean

sprintf(write_buffer, "%s", "Variable:value? \"mean\"");
ibwrt(scope, write buffer, strlen(write buffer));

/* read the answer */
ibrd(scope, read buffer, 99);
read buffer[ibcnt] = '\0';

printf("mean:%s\n", read buffer);

// *kkkkkkk Max

sprintf(write_buffer, "%s", "Variable:value? \"max\"");
ibwrt(scope, write buffer, strlen(write buffer));
ibrd(scope, read buffer, 99);

read buffer[ibcnt] = '\0';

printf("max:%s\n", read buffer);

// *kkkkkk*k Min

sprintf(write_buffer, "%s", "Variable:value? \"min\"");
ibwrt(scope, write buffer, strlen(write buffer));
ibrd(scope, read buffer, 99);

read buffer[ibcnt] = '\0';

printf("min:%s\n", read buffer);

// *kkkkkk*k PkPk

sprintf(write_buffer, "%s", "Variable:value? \"pkpk\"");
ibwrt(scope, write buffer, strlen(write buffer));
ibrd(scope, read buffer, 99);

read buffer[ibcnt] = '\0';

printf("pkpk:%s\n", read buffer);

// *kkkkkk*k StheV

sprintf(write_buffer, "%s", "Variable:value? \"stdDev\"");
ibwrt(scope, write buffer, strlen(write buffer));
ibrd(scope, read buffer, 99);

read buffer[ibcnt] = '\0';

printf("stdDe:v%s\n", read buffer);
// *kxxxkxx popylation

sprintf(write_buffer, "%s", "Variable:value? \"population\"");
ibwrt(scope, write buffer, strlen(write buffer));
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/* read the answer */
ibrd(scope, read buffer, 99);
read buffer[ibcnt] = '\0';

printf("population:%s\n", read buffer);

}

int main(){

int Dev, i;
char write buffer[100];
int status;

Dev = ibdev (BDINDEX, PRIMARY ADDR OF DMM, NO SECONDARY ADDR,
TIMEOUT, EQOTMODE, EOSMODE);

if (ibsta & ERR){

GPIBCleanup(Dev, "Unable to open device");
} else {

printf("My device id - %i", Dev);
}

status = ibwrt(Dev, write buffer, strlen(write buffer));

if (start_application(Dev)) {
printf("\nApplication started....\n");
}

recall setup(Dev, "Default");
do_single test(Dev);

// Print the results
display results(Dev);

exit_application(Dev);

/* leave the device back elegantly */
printf("Cleanup: Taking device offline\n");
ibon1(Dev, 0);
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Menu Structure

Figure 3-1 shows the relationship of the application-specific menus.

[ Rise Time
Fall Time
Positive Width F
Negative Width Preﬂ‘f"cy
High Time C;L'I‘; Gycle
g,eniral Low Time N-Cycle
5 °t° Positive Cy-Cy Duty
— ata i g
Select Active Clk-Data Data Frequency Negative Cy-Cy Duty
chch Data Period Posm\_/e Duty Cycle
Data TIE Negative Duty Cycle
Clear Al - Clock TIE
Setup Time -
Hold Time
- |_Clock-out
<
Clock Frequency —— Skew _
Clock Period T Ri
__ | Common Cycle Ise
Cycle-Cycle g | Start Edge _Fall
M o
N-Cycle Period 1st Meas: Start @ Edge :\1
Measurements —— Positive Duty Cycle Edge Increment —————————
Configure* Negative Duty Cycle — _
ClockTE - Rise
_ Clock Edge Fall hise
i S
; Both
Clock-Out Time Limit Range I—
— Max. Value
| Skew From Edge Min. Value
To Edge
Save | Limit Range [ Rise
Recall_| . Fall
Save/Recall Default Directory [Browse] Both
Minimize File name for Save/Recall: |_File name [Browse] _
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Main Vertical Autoset Mid —
s Ref Levels :ést:eresm Max. Value
umma — i
Inputs ry ~ | Low |_Min. Value
2nd ource =
Vertical Autoset Autoset
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*There is no configuration for the Rise Time, Fall Time, Positive Width, Negative Width, High Time, Low Time, Positive Cy - Cy
Duty, Negative Cy - Cy Duty, Data Frequency, Data Period, and Data TIE measurements.

Figure 3-1: Menu structure
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Figure 3-2 shows the structure of the remaining menus.
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cont. : Ref Levels
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True When Mid
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Control —| Pause
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Figure 3-2: Menu structure (continued)
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Measurements Menus

Select Active Menu

Configure Menu

This section describes the TDSJIT2 application parameters. You should refer to
the user manual for your oscilloscope for operating details of other controls, such
as front-panel buttons.

Refer to Appendix B: GPIB Command Syntax for a complete list of the GPIB
command syntax with the arguments, variables, and variable values that
correspond to the TDSJIT2 parameters.

NOTE. Incremental unit values shown are valid when the FINE button is enabled
on the oscilloscope.

There are four Measurements menu items: Select Active, Configure, Save/Recall,
and Minimize.

The options in the Select Active Measurements menu by area are as follows:

B General area: Rise Time, Fall Time, Positive Width, Negative Width, High
Time and Low Time

®  Clock area: Frequency, Period, Cycle-Cycle, N-Cycle, Positive Cy-Cy Duty
Cycle, Negative Cy-Cy Duty Cycle, Positive Duty Cycle, Negative Duty
Cycle, Clock TIE

®  Data area: Data Frequency, Data Period, and Data TIE
®  (Clk-data area: Setup Time, Hold Time, and Clock-Out
®  Ch-Ch area: Skew

You do not need to configure the following measurements:

®  General area (all): Rise Time, Fall Time, Positive Width, Negative Width,
High Time and Low Time

B (Clock area: Positive Cy-Cy Duty and Negative Cy-Cy Duty

®  Data area (all): Data Frequency, Data Period, and Data TIE
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Save/Recall Menu

Table 3-1 lists the parameters for the Configure Measurements menu and the
selections or range of values available for each.

Table 3-1: Configure Measurements menu parameters

Parameter Selections Default setting
Common Cycle Start Edge | Rise, Fall Rise

N= 110 1,000 in 1 cycle units 6

1st Meas Start Edge At 1t0 1,000 in 1 cycle units 1

Edge Increment i, N 1

Clock Edge Rise, Fall Rise

Data Edge Rise, Fall, Both Rise

Limit Range: Max. Value -500.0 ms to 500.0 ms in 10 ps units | 1.0 us

Limit Range: Min. Value

-500.0 ms to 500.0 ms in 10 ps units

0's (-1.0 us for Skew)

From Edge

Rise, Fall, Both

Rise

To Edge

Same as From, Opposite as From

Same as From

Table 3-2 lists the parameters for the Save/Recall Measurements menu and the
selections available for each.

Table 3-2: Save/Recall Measurements menu parameters

Parameter Selections Default setting

Save None C:\TekApplications\tdsjit2\setup\setup.ini
Recall None C:\TekApplications\tdsjit2\setup\setup.ini
Default None

Inputs Menus

There are four Inputs menus: Main, 2nd, Qualify, and Gating/Other.

Main and 2nd Menus

Table 3-3 lists the parameters for the Inputs:Main and Inputs: 2nd menus and the

selections or range of values available for each.

3-4
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Table 3-3: Inputs: Main and Inputs: 2nd menu parameters

Parameter Selections Default setting
Source* Ch1, Ch2, Ch3, Ch4, Ref1, Ref2, Ref3, Ref4, | Ch1

Math1, Math2, Math3, Math4
Vertical Autoset None
Mid -10.0 Vto 10.0 Viin 1 mV units 0.00V
Hysteresis 0Vto5.0Vin1mV units 10.00 mV
High** -10.0 Vto 10.0 Vin 1 mV units 1.00V
Low*™ -10.0 Vto 10.0 Viin 1 mV units -1.00V

*  For two-channel measurements that include a clock, select the channel (reference
memory or math waveform) for the clock signal as the Main Input Source. For Data
measurements, select the channel for the data signal as the Main Input Source.

*  Only available for the waveform defined in the Inputs: Main menu.

Table 3-4 lists the parameters for the Autoset Ref Level menu and the selections
or range of values available for each.

Table 3-4: Autoset Ref Level menu parameters

Parameter Selections Default setting
Mid 1% t0 99% in 1% units 50%

Hysteresis 0% to 50% in 1% units 3%

High* 2% t0 99% in 1% units 90%

Low* 1% to 98% in 1% units 10%

*  Only available for the waveform defined in the Inputs: Main menu.

NOTE. The Deskew command button in the Inputs: 2nd menu starts the deskew
utility. Refer to the Deskewing the Probes and Channels on page 1-6 for more

information.

Qualify Menu  Table 3-5 lists the parameters for the Inputs: Qualify menu and the selections or
range of values available for each.

TDSJIT2 Jitter Analysis Application User Manual
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Table 3-5: Inputs: Qualify menu parameters

Parameter Selections Default setting
Source Ch1, Ch2, Ch3, Ch4, Ref1, Ref2, Ref3, Ref4, | Ref3

Math1, Math2, Math3, Math4
Ref Levels Same as in Table 3-3 See Table 3-3
State Off, On Off
True When Low, High High

Gating/Other Menu  Table 3-6 lists the parameters for the Inputs: Gating/Other menu and the
selections or range of values available for each.

Table 3-6: Inputs: Gating/Other menu parameters

Paramter Selections Default setting
Horiz Check None

Gate w/Cursors On, Off Off

Acq Timeout Auto, User Auto

Timeout 30 sec to 24 hrs in 30 sec units* 30 sec*

*  When User is selected in the Acq Timeout option.

View Menus

There are no parameters for the View Results or View Warnings menus.

Plot Menus

There are two Plot menus: Select Plot, and Vert/Horiz Axis Plot.

Select Plot Menu  The Select Plot menu contains the following parameters:
m  List of Active Measurements
®  Plot Type options: Histogram, Time Trend, Cycle Trend, Spectrum, and none
®  Display option

m  Current Ref Use table; there is one row for each reference memory: Refl,
Ref2, Ref3, and Ref4
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Vert/Horiz Axis Plot Menu

The parameters for the Vertical/Horizontal Axis Plot menu vary according to the
format you select for the Plot Type option.

Histogram Plot. Table 3-7 lists the parameters for the Histogram plot format in
the Vert/Horiz Axis Plot menu and the selections or range of values available for
each.

Table 3-7: Histogram: Vert/Horiz Axis Plot menu parameters

Parameter Selections Default setting
Vertical
Max. Height 1.0 Div to 4.0 Div in 1.0 Div units 4.0 Div
Scale Log, Linear Linear
Bin Resolution Coarse, Med, Fine Med
Autoset None

The parameters for the Horizontal Center and Horizontal Span vary by measure-
ment. Table 3-8 lists the parameter selections and range of values.

Table 3-8: Horizontal Center and Span parameters

Measurements Parameter | Selections Default setting
Rise Time, Fall Time, Positive Width, Negative Width, High Time, | Center 5.0 ps to 10.0 s in units of 5 ps 5s
Low Time, Period, and Data Period .

Span 10.0 psto 10.0 s inunitsof 10ps | 10s
Cycle-Cycle, N-Cycle, Positive Cy-Cy Duty, Negative Cy-Cy Duty, | Center -5.0 st0 5.0 s in units of 5 ps 0s
TIE, Data TIE, Setup Time, Hold Time, Clock-Out Time, and Skew N

Span 10.0 psto 10.0 s in unitsof 10ps | 10s
Frequency, Data Frequency Center 1 Hz to 10.0 GHz in units of 0.5 Hz | 5 GHz

Span 1Hzto 10.0 GHz in units of 1 Hz | 10 GHz
Positive Duty, and Negative Duty Center 0% to 100% in units of 5m% 50%

Span 10m% to 100% in units of 10m% | 100%

TDSJIT2 Jitter Analysis Application User Manual

The Horizontal area includes two readouts that display the following values:
B Min shows: Center - Span/2

B Max shows: Center + Span/2

Time Trend Plot. Table 3-9 lists the parameters for the Time Trend plot format in
the Vert/Horiz Axis Plot menu and the selections or range of values available for
each.
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Log Menus

Statistics Menu

3-8

Table 3-9: Time Trend: Vert/Horiz Axis Plot menu parameter

Default setting
4.0 Div

Selections
1.0 Div to 8.0 Div in 1.0 Div units

Parameter

Vertical Max. Height

Cycle Trend Plot. Table 3-10 lists the parameters for the Cycle Trend plot format
in the Vert/Horiz Axis Plot menu and the selections or range of values available
for each.

Table 3-10: Cycle Trend: Vert/Horiz Axis Plot menu parameters

Parameter Selections Default setting
Vertical Max. Height | 1.0 Div to 8.0 Div in 1.0 Div units 4.0 Div
Horizontal Length 500 pt to 50,000 pt in 500 units 500 points

Spectrum Plot. Table 3-10 lists the parameters for the Spectrum plot format in
the Vert/Horiz Axis Plot menu and the selections or range of values available for
each.

Table 3-11: Spectrum: Vert/Horiz Axis Plot menu parameters

Parameter Selections Default setting
Vertical

Max. Height 1.0 Div to 8.0 Div in 1.0 Div units 4.0 Div

Scale dB, Linear Linear
Window Data On, Off On

There are two Log menus: Statistics and Min/Max Wfm.

Table 3-12 lists the parameters for the Log Statistics menu and the selections or
range of values available for each.

Table 3-12: Log Statistics menu parameters

Parameter Selections Default setting
Logging On, Off Off
Clear None
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Table 3-12: Log Statistics menu parameters (Cont.)

Parameter Selections Default setting

Save Current None

Log File Name: | Any file C:\TekApplications\tds;jit2\log\results
Browse

Min/Max Wfm Menu  Table 3-13 lists the parameters for the Log Min/Max Wfm menu and the

selections or range of values available for each.

Table 3-13: Log Min/Max Wfm menu parameters

Parameter Selections Default setting

Saving On, Off Off

Select Directory: Any directory C:\TekApplications\tdsjit2\waveforms
Browse

The Log Min/Max Wfm menu includes readouts that display the file names for
the minimum and maximum worst case waveforms for the Main input and for the
2nd input, if used. Table 2-20 on page 2-25 lists the waveform file names.

Help Menu

There are no parameters for the Help menu.

Sequence Control Menu

Table 3-14 lists the parameters in the Sequence Control menu and the selections

available.

Table 3-14: Sequence Control menu parameters

Parameter Selections Default setting
Mode Single, Free Run, Single No Acq Single

Start (or Continue) None

Pause None

Stop None

Reset None

TDSJIT2 Jitter Analysis Application User Manual
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Appendix A: Measurement Algorithms

The TDSJIT2 application can take timing measurements from one or two
waveforms. The number of waveforms used by the application depends on the
type of measurement being taken.

Single waveform measurements are: Rise Time, Fall Time, Positive Width,
Negative Width, High Time, Low Time, Clock Period, Clock Frequency,
Cycle-Cycle, N-Cycle, Positive Cycle-Cycle Duty, Negative Cycle-Cycle Duty,
Positive Duty Cycle, Negative Duty Cycle, Clock TIE, Data Period, Data
Frequency, and Data TIE. Dual waveform measurements are: Setup Time, Hold
Time, Clock-to-Output, and Skew.

Oscilloscope Setup Guidelines
For all measurements, use the following guidelines to set up the oscilloscope:
1. The signal is any channel, reference, or math waveform.

2. The vertical scale for the waveform must be set so that the waveform does
not exceed the vertical range of the oscilloscope.

3. The sample rate must be set small enough to capture sufficient waveform
detail and avoid aliasing.

4. Longer record lengths increase measurement accuracy.

Test Methodology
The application performs the measurement according to the following steps:
1. Imports the current waveform.

2. Checks that the reference voltage level plus or minus half the hysteresis are
within the 2.5% to 97.5% range of the peak-to-peak waveform values.

3. Checks that there are a minimum number of edges in the waveform to
calculate the measurement as follows:

®  Single edge: Rise Time, Fall Time
B One edge pair: Pulse Width, High Time, Low Time
®  Two cycle-start edges: Period, Frequency, Duty Cycle

®  Three cycle-start edges: Cycle-to-Cycle, TIE
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® 2N + 1 cycle-start edges: N-Cycle
®  Two edges on each of two waveforms: Skew
4. Performs the measurement.

5. Displays the results as statistics, saves the results as a plot format in a
reference waveform, or saves the results to a data log file.

Edge-Timing Measurements

All timing measurements are based on the time locations of edges within each
acquisition. Edge conditions are defined in the setup menu of each timing
measurement. 7, represents the acquisition edge times where # is an index
between 1 and the number of edges in the acquisition.

The “i” and “j” represent dissimilar acquisition indices. Dissimilar acquisition
indices occur when the correlation between clock edges and data transitions are
not one-to-one.

Single Waveform Measurements

The Rise Time and Fall Time algorithms use both the VRefHi and VRefL.o
reference voltage levels. Each edge is defined by the slope, voltage reference
level (threshold), and hysteresis.

Rise Time Measurement  The Rise Time measurement is the time difference between when the VRefHi
reference level is crossed and the VRefLo reference level is crossed on the rising
edge of the waveform.

The application calculates this measurement using the following equation:
TRixe — THi+ _TLo+

Where: TRise jg the rise time.
THi* js the VRefHi crossing on the rising edge.

TLo+ is the VRefLo crossing on the rising edge.

Fall Time Measurement  The Fall Time measurement is the time difference between when the VRefLo
reference level is crossed and the VRefHi reference level is crossed on the falling
edge of the waveform.
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The application calculates this measurement using the following equation:
TFall — TL()— _THi—

Where: TFall s the fall time.
TLo- is the VRefLo crossing on the falling edge.

THi- is the VRefHi crossing on the falling edge.

Positive and Negative = The Positive Width and the Negative Width measurements are the difference in
Width Measurements  time (positive or negative) between the leading edge and trailing edge of a pulse.
The trailing edge is the opposite polarity (direction) of the leading edge.

The application calculates this measurement using the following equation:

Wi, = T,-T;
W, =T,;-T,
Where: W+ is the positive pulse width.

W~ is the negative pulse width.
T~ is the VRefMid crossing on the falling edge.
T+ is the VRefMid crossing on the rising edge.

High Time Measurement  The High Time measurement is the amount of time that a waveform cycle is
above the VRefHi voltage reference level.

The application calculates this measurement using the following equation:
THi — THi— _THi+

Where: THijs the high time.
THi- is the VRefHi crossing on the falling edge.

THi* js the VRefHi crossing on the rising edge.

Low Time Measurement  The Low Time measurement is the amount of time that a waveform cycle is
below the VRefLo voltage reference level.
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A-4

Clock Frequency
Measurement

Clock Period
Measurement

Cycle-to-Cycle
Measurement

The application calculates this measurement using the following equation:
Tl,ow — TLo+ _TL()—

Where: TLow is the low time.
TLo+ is the VRefLo crossing on the rising edge.

TLo- is the VRefLo crossing on the falling edge.

The Clock Frequency measurement calculates the inverse of the clock period for
each cycle.

The application calculates this measurement using the following equation:
FCIuck — I/PClock

Where: FClockis the clock frequency.

PClock s the period.

The Clock Period measurement calculates the duration of a cycle as defined by a
start and a stop edge. Edges are defined by slope, threshold, and hysteresis.

The application calculates this measurement using the following equation:

P(y:l(wk =T

n

+1_Tn

Where: PClock s the clock period.
T is the VRefMid crossing time in the Common Cycle Start Edge

direction.

The Cycle-to-Cycle measurement calculates the difference in period measure-
ments from one cycle to the next.

The application calculates this measurement using the following equation:

— Clock Clock
AP, = pClock_pC

n+1

Where: AP is the difference between adjacent periods.

PClock s the period.
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N-Cycle Measurement  The N-Cycle measurement calculates the difference in period measurements
from cycles that are a defined number of cycles apart.

The application calculates this measurement using the following equation:
ANP, = (T} =Ty HT T

Where: ANP is the difference between adjacent N-cycle periods.

T+ is the VRetMid crossing time in the Common Cycle Start
Edge direction.

Positive and Negative = The Positive Cycle-to-Cycle Duty and Negative Cycle-to-Cycle Duty measure-
Cycle-to-Cycle Duty = ments calculate the ratio of the positive (or negative) portion of the cycle relative
Measurements to the period from one cycle to the next.

The application calculates this measurement using the following equation:

AW, = W, =W,
AW, =W, -W,,

Where: AW is the positive cycle-to-cycle duty.
AW~ is the negative cycle-to-cycle duty.
W+ is the positive pulse width.

W~ is the negative pulse width.

Positive and Negative ~ The Positive Duty Cycle and Negative Duty Cycle measurements calculate the
Duty Cycle Measurements  ratio of the positive (or negative) portion of the cycle relative to the period.

The application calculates this measurement using the following equation:

D+ — W+/Pclock

D, = W, /P

Where: D+ is the positive duty cycle.
D~ is the negative duty cycle.

W+ is the positive pulse width.
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Clock TIE Measurement

Data Frequency
Measurement

Data Period Measurement

A-6

W~ is the negative pulse width.

PClock s the period.

The Clock TIE measurement calculates the difference in time between the
designated edge on a sampled clock waveform to the designated edge on a
calculated clock waveform with a constant frequency (zero jitter).

The application calculates this measurement using the following equation:
TIES™ = T,-T,

Where: TIEClock is the clock time interval error.
T, is the specified clock edge.

T', is the calculated ideal clock edge.

The Date Frequency measurement calculates the inverse of the data period for
each cycle.

The application calculates this measurement using the following equation:
FData =1 / PDam

Where: FData g the data frequency.

P is the period.

The Date Period measurement calculates the duration of a cycle as defined by a
start and a stop edge. Edges are defined by slope, threshold, and hysteresis.

The application calculates this measurement using the following equation:
PDuta — (Tfam_Tf_ulm)/(Cn_Cn—l)

Where: PData jg the data period.
TData js the VRefMid crossing time in either direction.

C, is the calculated clock cycle location of TPaa,
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Data TIE Measurement  The Date TIE measurement calculates the difference in time between the
designated edge on a sampled data waveform to the designated edge on a
calculated data waveform with a constant frequency (zero jitter).

The application calculates this measurement using the following equation:
TIEl)ata — Tl)ata _Tl)uta’

Where: TIEData js the data time interval error.

TData ig the data edge, the VRefMid crossing time in either
direction.

TPata’ g the calculated ideal data edge time.

Dual Waveform Measurements

Edge conditions are defined for two waveforms. These algorithms use the VRef
values as the reference voltage level. Each edge is defined by the slope, voltage
reference level (threshold), and hysteresis.

Setup Time Measurement  The Setup Time measurement is the elapsed time between the designated edge of
a data waveform and when the clock waveform crosses its own voltage reference
level. The closest data edge to the clock edge that falls within the range limits is
used.

The application calculates this measurement using the following equation:
T_ngemp — Ti_Ti)um

Where: TSetup is the setup time.

T is the Main input (clock) VRefMidpain crossing time in the
specified direction.

TPata ig the 2nd input (data) VRefMidayg crossing time in the
specified direction.

Hold Time Measurement = The Hold Time measurement is the elapsed time between when the clock
waveform crosses its own voltage reference level and the designated edge of a
data waveform. The closest data edge to the clock edge that falls within the range
limits is used.
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A-8

Clock-to-Output Time
Measurement

Skew Measurement

The application calculates this measurement using the following equation:
TH()ld — Tl)ata _T.

Where: THold ig the hold time.

T is the Main input (clock) VRefMidpain crossing time in the
specified direction.

TPata s the 2nd input (data) VRefMidppg crossing time in the
specified direction.

The Clock-to-Output Time measurement is the elapsed time between when the
clock waveform crosses its own voltage reference level and the designated edge
of a data waveform. The closest data edge to the clock edge that falls within the
range limits is used.

The application calculates this measurement using the following equation:
TClkOut — Tdo -T.

Where: TCkOut js the clock-to-output time.

T is the Main input (clock) VRefMidpain crossing time in the
specified direction.

T40 is the 2nd input (data) VRefMidp,q crossing time in the
specified direction.

The Skew measurement calculates the difference in time between the designated
edge on a principle waveform to the designated edge on another waveform. The
closest data edge to the clock edge that falls within the range limits is used.

The application calculates this measurement using the following equation:
TSkew — T_TS

Where: S is the period.

T is the Main input VRefMidp,i, crossing time in the specified
direction.

TS is the 2nd input VRefMid;,pg crossing time in the specified
direction.
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Calculating Statistics

Maximum Value

Minimum Value

Mean Value

Standard Deviation Value

The application calculates statistics for each selected measurement, and logs the
statistics on a cycle-cycle basis in a fairly large waveform. The standard statistics
are for the Maximum, Minimum, Mean, Standard Deviation, and Population.

The application continues to calculate statistics until you press the Reset button
in the Sequence Control menu. This resets all values to zero.

The application calculates this value using the following equation:

Max (X) = Highest value of X

The application calculates this value using the following equation:

Min (X) = Lowest value of X

The application calculates this value using the following equation:

N
Mean(X) = X = 3 > X,

n=1

It may seem odd that the equation for the estimate of the Standard Deviation
contains a 1/(N-1) scaling factor. If you knew the true mean of X and used it in
place of the estimated mean X, then you would, in fact, scale by 1/N. But, X is an
estimate and is likely to be in error (or bias), causing the estimate of the Standard
Deviation to be too small if scaled by 1/N. This is the reason for the scaling
shown in the equation. (Refer to Chapter 9.2 in A. Papoulis, Probability, Random
Variables, and Stochastic Processes, McGraw Hill, 1991.)

The application calculates this value using the following equation:

N
L 1 ™2
Standard Deviation (X) = o0, = —— X, —X)
( \/ (N‘l); (
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Cycle-Cycle Value  The application calculates this value using the following equation:

ch,, = X,— X,

Max Positive Difference  The application calculates this value using the following equation:
Value

Max (X.c) = Highest value of X

Max Negative Difference  The application calculates this value using the following equation:
Value

Max (-Xcc) = —Lowest value of X¢c

Mean Difference  The application calculates this value using the following equation:
(Cycle-Cycle Mean) Value

Mean ((X.|) = Average value of X magnitude

RMS (Root Mean Square)  The application calculates this value using the following equation:
Difference Value

N
RMS (ch) = Xpus = % Z ch,,2
n=1

Population Value  The application calculates this value using the following equation:

Population (X) = N
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Appendix B: GPIB Command Syntax

This appendix describes the GPIB command syntax that you can use in your
GPIB program to do the following tasks:

®m  Start the TDSJIT2 application

®  Recognize an active application with GPIB protocol
B Program and read application setup parameters

B Sequence measurements

®  Read measurement results

To use GPIB commands with your oscilloscope, you can use the following
reference materials:

®  The tdsjit2ctrl.c file on the oscilloscope hard drive and on the optional
applications compact disc for an example of a GPIB program that can
execute the application

®  The GPIB Program Example section for guidelines to use while designing a
GPIB program

B The Parameters Reference section for incremental units and default values of
TDSJIT2 parameters

®  The programmer information in the online help of your oscilloscope

Description. Gives the function of the command, conditions of its use, and its
interactions with other commands.

Syntax. Gives the valid select and query command forms. The required argu-
ments are listed in their proper order.

For example, in the syntax definition

PATH= <Ad><Ars>

the arguments <Ad> and <Ars> are required in the order indicated

Arguments. The arguments to a command are defined along with their range of
values.

Returns. Defines the data returned in response to a command query.
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Starting and Setting Up the Application

To start the TDSJIT2 application, you must send the oscilloscope the following
GPIB command:

application:activate "Jitter Analysis 2"

The application uses the VARIABLE:VALUE command with arguments to
execute the application. The set of arguments does not include variable names
and variable values necessary to select and configure the measurements in the
GPIB program.

You must manually set up the application and oscilloscope by selecting and
configuring the measurements that you want to take through your GPIB program,
and save the setup. To save a setup, refer to Saving a Setup on page 2-28. You
need to use the name of the saved setup file as the value for the setupDirectory
and saveName variables in your GPIB program.

VARIABLE:VALUE TDS COMMAND

Description

Syntax

Arguments and Returns

/N

VARIABLE:VALUE TDS COMMAND accepts string arguments for a control or
data variable and a value to which to set the argument.

VARIABLE:VALUE
VARIABLE:VALUE "<variable name>","<variable value>"

the arguments <variable name> and <variable value> are required
in the order indicated.

VARIABLE:VALUE? "<variable name>" for query

Table B-1 lists the arguments, their function, and the query returns.

CAUTION. Commands are case and space sensitive. Your program will not
operate correctly if you do not follow the capitalization and spaces precisely.

B-2
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Table B-1: VARIABLE:VALUE TDS COMMAND arguments and queries

Variable name Variable value Function Query form
application {exit} Terminates the active application Returns the name of the currently
active application
Sequencer
sequenceMode {Single_NoAcq, Free Run, Single} | Sets the sequencer mode Returns the sequencer mode
sequencerState {Ready, Paused, Sequencing} Sets the state of the sequencer: Returns the state of the sequencer
Sequencing, Ready, Paused
reset {results} Clears the active measurement No query form
results and the plot displays
Save/Recall
setup {Default, Recall, Save} Sets the Save/Recall/Default action | No query form
recallName Any string from 1 to 8 characters | Sets the recalled setup file name Returns the saved setup file name
from A to Z and/or zero to nine
saveName Any string from 1 to 8 characters | Sets setup file name Returns the setup file name
from A to Z and/or zero to nine
setupDirectory {Default} Sets the directory to the default No query form
directory
Logging Results
logAnnotate* A string from 1 to 20 characters | Provides custom annotation to the | Returns the logAnnotate string when
from A to Z and/or zero to nine statistics log file set
loggerDestination A string using characters from A | Sets the statistics log file name Returns the statisics log file name
to Z and/or zero to nine
logDirectory {Default} Sets the directory to the default No query form
directory
logger {Reset} Clears the current statistics log file | No query form
loggerState {On, Off} Sets the state of the statistics log; Returns the state of the data log
when on, the statistics from the
current acquisition are logged
Result Variables
resultFor {CF, CP, TIE, CCP, NCP, PCCD, Sets the measurement for which Returns the selected measurement;

NCCD, PDC, NDC, PW, NW,
RISE, FALL, HIGH, LOW, DF, DP,
DTIE, SU, HOLD, TCO, SKEW}

results are requested

see Table B-2 for the queries
associated with resultFor

* Custom annotation in the data log file is only available through GPIB execution of the application.
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You need to use the VARIABLE:VALUE? form to enter measurement results
queries in your GPIB program. Before you can do this, you must first set the
measurement with the resultFor command. Table B-2 lists the measurement

results queries for the measurement selected in the resultFor variable.

Table B-2: Measurement results queries

Variable name

Function

calcFrequency Returns the calculated frequency of the result for the measurement selected in the resultFor variable
error Returns the error, if any, from the last measurement taken

max Returns the maximum value of the result for the measurement selected in the resultFor variable

mean Returns the mean value of the result for the measurement selected in the resultFor variable

min Returns the minimum value of the result for the measurement selected in the resultFor variable

pkpk Returns the peak-to-peak value of the result for the measurement selected in the resultFor variable
population Returns the population for the result for the measurement selected in the resultFor variable

positiveMax Returns the positive maximum value for the result of the measurement selected in the resultFor variable
positiveMean Returns the positive mean value of the result for the measurement selected in the resultFor variable
positivePopulation Returns the positive population for the result for the measurement selected in the resultFor variable
negativePopulation Returns the negative population for the result for the measurement selected in the resultFor variable
negativeMax Returns the negative maximum value of the result for the measurement selected in the resultFor variable
negativeMean Returns the negative mean value of the result for the measurement selected in the resultFor variable
stdDev Returns the standard deviation value of the result for the measurement selected in the resultFor variable
warning Returns the warning, if any, from the last measurement taken

Table B-3 lists the results returned for various measurements.

Table B-3: Results returned by measurements

Measurement

Results returned

Al

population, stdDev

CF, CP, TIE, PDC, NDC, PW, NW, RISE, FALL,
HIGH, LOW, DF, DP, DTIE, SU, HOLD, TCO, SKEW

mean, max, min, pk-pk

CCP, NCP, PCCD, NCCD

positiveMean, positiveMax, positivePopulation, negativeMean, negativeMax,
negativePopulation,

TIE, DTIE

calcFrequency* (appears on screen as Est Freq in a results.csv file)

*  For TDSJIT2 versions below V1.1, additional measurements returned calcFrequency.
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Index
Symbols

.csv file
custom annotation with GPIB command, 2-24
example, 2-17
format, 2-24
viewing in a spreadsheet program, 2-27
viewing with Wordpad, 2-40

A

acquiring data
reset results, 2-15
Sequence mode, 2-15
waveforms, 2-14
Acquisition Timeout, 2-14
address, Tektronix, xiii
application
basic functions with an oscilloscope, 2-2
closing, 2-3
description, 1-1
deskewing probes and channels, 1-6
directory names, 2-3
enabling, 1-6
exiting, 2-30
file name extensions, 2-3
installing
compact disc, 1-5
floppy disk, 1-5
interface, 2-1
logging results
as statistics, 2-23
for worst case waveforms, 2-24
menu structure, 3-1
minimizing and maximizing, 2-2
recalling setups, 2-27
returning, 2-3
saving results to a file, 2-23
saving setups, 2-27
setting up
gating, 2-13
inputs, 2-9
measurements
clearing all, 2-4
configuration, 2-6
selection, 2-4
qualifiers, 2-12
vertical settings, optimize, 2-13
starting, 2-31
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test methodology, A-1
updates, 1-2
viewing results
as plots, 2-18
as statistics, 2-18
area, definition, 2-2
Autoset Ref Level menu, value entry methods, 2-11
axis, vertical and horizontal in plots, 2-20

box, 2-2
Browse button, 2-24
buttons

command, 2-2

option, 2-2

Sequence Control, 2-14

C

changing oscilloscope settings during a measurement,
2-15
channels
assignments, 1-9
deskewing, 1-6
Clear All command button, 2-4
Clear command button, 2-23
Clear Warnings command button, 2-16
Clk-Data area, configuration, 2-8
Clock Frequency measurement, application equation,
A-4
Clock Period measurement
application equation, A-4
tutorial lesson, 2-33
Clock TIE measurement, application equation, A-6
Clock-to-Output measurement
application equation, A-8
tutorial lesson, 2-38
closing the application, 2-3
command button, 2-2
command syntax, GBIP protocol, B-1
Common Cycle Start Edge option, 2-6
compact disc, 1-5
Configure Measurements menu, 2-6
Clk-Data area, 2-8
Common Start Edge option, 2-6
General area, 2-6
N-Cycle, 2-7
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Index

no configuration for some measurements, 2-6
Skew, 2-8
connecting to a system under test, 1-9
contacting Tektronix, xiii
conventions, Xii
cursors, gating with, 2-14
Cycle Trend plot, 2-19
Vert/Horiz axis, 2-21
Cycle-Cycle statistics, application equation, A-10
Cycle-to-Cycle measurement, application equation, A-4

D

data log file
Clear command button, 2-23
custom annotation with GPIB command, 2-24
example, 2-17
format, 2-24
Save Current button, 2-23
saving the results tutorial lesson, 2-40
viewing, 2-27
default setup, 2-30
Deskew option, 2-12
deskewing probes and channels, 1-6
dim menus or options, 1-2
directory names, 2-3
downloading updates, 1-2

E

edge-time measurements, A-2
enabling the application, 1-6
exiting the application, 2-30

F

Fall Time measurement, application equation, A-3
file names
extensions, 2-3
worst case waveforms, 2-25
filtering out information for analysis, 2-15
floppy disks, 1-5
Free Run sequence mode, 2-15

G

gating with cursors, 2-14
General area, configuration, 2-6
GPIB protocol

case sensitive, B-2

command syntax, B-1

Index-2

custom annotation for the data log file, 2-24
guidelines, 2-43
oscilloscope operation, xi
program example, 2-44
grayed out menus or options, 1-2

H

Help menu, no parameters, 3-9
help, online, 2-2
High Time measurement, application equation, A-3
Histogram plot, 2-19

Vert/Horiz axis, 2-20
Hold Time measurement, application equation, A-7
horizontal settings, check, 2-14

Inputs menus
2nd, 2-9, 2-11
parameters, 3-4
Gating/Other, 2-13
parameters, 3-6
Main, 2-9
parameters, 3-4
Qualify 1, 2-12
parameters, 3-5
Summary, 2-9
installation
application
compact disc, 1-5
floppy disk, 1-5
downloading updates, 1-2
up-to-date procedures, xii
interface, application, 2-1

J

JRE, 1-4

K

keypad entry, 2-11

L

label, location on oscilloscope, 1-3
leaving the application, 2-30
lessons. See tutorial lessons

list box, 2-2
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localizing measurements, 2-15
log file, example, 2-17
Log menus
Min/Max Wfm, 2-24
parameters, 3-9
Statistics, 2-23
parameters, 3-8
Low Time measurement, application equation, A-3

Max Negative Difference statistics, application equation,

A-10

Max Positive Difference statistics, application equation,

A-10

max1, minl, max2 and min2 waveform files sources,

2-25
maximizing the application, 2-2
Maximum statistics, application equation, A-9
Mean Difference (Cycle-Cycle Mean) statistics,
application equation, A-10
Mean statistics, application equation, A-9
measurements
application equations
Clock Frequency, A-4
Clock Period, A-4
Clock TIE, A-6
Clock-to-Output, A-8
Cycle-to-Cycle, A-4
Fall Time, A-3
High Time, A-3
Hold Time, A-7
Low Time, A-3
N-Cycle, A-5
Negative Cycle-to-Cycle Duty, A-5
Negative Duty Cycle, A-5
Negative Width, A-3
Positive Cycle-to-Cycle Duty, A-5
Positive Duty Cycle, A-5
Positive Width, A-3
Rise Time, A-2
Setup Time, A-7
Skew, A-8
statistics
Cycle-Cycle, A-10
Max Negative Difference, A-10
Max Positive Difference, A-10
Maximum, A-9
Mean, A-9

Mean Difference (Cycle-Cycle Mean), A-10

Minimum, A-9
Population, A-10
RMS Difference, A-10
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Standard Deviation, A-9
TIE, A-6, A-7
application test method, A-1
descriptions, 2-5
focusing on a part of the waveform, 2-15
oscilloscope changes, 2-15
removing all Active, 2-4
setting up, 2-4
taking, 2-14
test algorithms, A-1
tutorial lessons, 2-31
Measurements menus
Configure, 2-6
parameters, 3-3
Minimize, 2-2
Save/Recall, 2-27
parameters, 3-4
Select Active, 2-4
parameters, 3-3
menu structure, overview, 3-1
menus
Help, 2-2
Inputs
2nd, 2-9, 2-11
Gating/Other, 2-13
Main, 2-9
Qualify 1, 2-12
Log
Min/Max Wfm, 2-24
Statistics, 2-23
Measurements
Configure, 2-6
Save/Recall, 2-27
Select Active, 2-4
Plot
Select Plot, 2-18
Vert/Horiz Axis, 2-20
Sequence Control, 2-14
View
Results, 2-18
Warnings, 2-16
messages, warning, 2-16
minimizing the application, 2-2
Minimum statistics, application equation, A-9
MP knob, 2-11
multipurpose knob entry, 2-11

N-Cycle measurement
application equation, A-5
configuration, 2-7
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Negative Cycle-to-Cycle Duty measurement, application
equation, A-5

Negative Duty Cycle measurement, application
equation, A-5

Negative Width measurement, application equation, A-3

not enough cycles, error message, 2-15

0]

online help, 2-2

option button, 2-2

Option Installation key, 1-6

oscilloscope
accessing functions, 2-3
basic functions with the application, 2-2
compatibility, 1-1
deskewing probes and channels, 1-6
full display, 2-3
setup guidelines, A-1

P

parameters, reference, 3-3
phone number, Tektronix, xiii
Plot menus
configuring, 2-19
Select Plot, 2-18
parameters, 3-6
Vert/Horiz Axis
Cycle Trend, 2-21
parameters, 3-8
Histogram, 2-20
parameters, 3-7
Spectrum, 2-22
parameters, 3-8
Time Trend, 2-21

parameters, 3-7
Population statistics, application equation, A-10

Positive Cycle-to-Cycle Duty measurement, application
equation, A-5
Positive Duty Cycle measurement, application equation,
A-5
Positive Width measurement, application equation, A-3
probes, deskewing, 1-6
product
compatibility, 1-1
description, 1-1
requirements and restrictions, 1-2
updates, 1-2
product support, contact information, xiii

Index-4

Q

quitting the application, 2-30

Readme.txt file
floppy disk, 1-5
web, 1-2
recalling
reference waveforms, 2-32
saved setups, 2-29
reference voltage levels, 2-10
reference waveforms, recalling, 2-32
requirements and restrictions, 1-2
Reset All, 2-15, 2-23
results, reset and clear, 2-23
returning to the application, 2-3
Rise Time measurement, application equation, A-2
RMS Difference statistics, application equation, A-10

S

Save Current button, 2-23
Save/Recall Measurements menu, 2-27
Select Active Measurements menu, 2-4
Select Plot menu, 2-18
Sequence Control menu
buttons, 2-14
parameters, 3-9
Sequence mode, 2-15
service support, contact information, xiii
Setup Time measurement, application equation, A-7
setups
default, 2-30
recalling, 2-29
saving, 2-28
Single No Acq sequence mode, 2-15
Single sequence mode, 2-15
single waveform measurements, A-2
Skew measurement
application equation, A-8
configuration, 2-8
Spectrum plot, 2-19
Vert/Horiz axis, 2-22
Standard Deviation statistics, application equation, A-9
statistics, application equation
Cycle-Cycle, A-10
Max Negative Difference, A-10
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Max Positive Difference, A-10
Maximum, A-9
Mean, A-9
Mean Difference (Cycle-Cycle Mean), A-10
Minimum, A-9
Population, A-10
RMS Difference, A-10
Standard Deviation, A-9
system under test, 1-9

T

taking measurements, 2-14

technical support, contact information, xiii

Tektronix, contacting, xiii

terms, xii

TIE measurement, application equation, A-6, A-7

Time Trend plot, 2-19
Vert/Horiz axis, 2-21

Timeout, 2-14

tutorial lessons, 2-31
Clock Period measurement, 2-33
Clock-to-Output measurement, 2-38
recalling waveforms. See saving a setup
saving the results to a data log file, 2-40
viewing the .csv file with Wordpad, 2-40

U

URL, Tektronix, xiii

TDSJIT2 Jitter Analysis Application User Manual

vV

value entry methods, 2-11
VARIABLE:VALUE TDS COMMAND, B-2
Vert/Horiz Axis menu

Cycle Trend plot, 2-21

Histogram plot, 2-20

Spectrum plot, 2-22

Time Trend plot, 2-21
vertical settings, optimize, 2-10
View Results menu, 2-18

no parameters, 3-6
View Warnings menu, 2-16

no parameters, 3-6
viewing results

as plots, 2-18

as statistics, 2-18

w

warning messages, viewing, 2-16
web site, downloading updates, 1-2
web site address, Tektronix, xiii
worst case waveforms

file names, 2-25

logging data to a file, 2-24
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